GemSTAR

Infusion Pump

System Operating Manual

For use with the Hospira GemStar® Pain Management Pump

List 13150-04-07/08
Hospira GemStar® Infusion Pump
System Operating Manual

For use with the
Hospira GemStar Pain Management Pump

List 13150-04-07/08

PLEASE
Read this entire manual before using the Hospira GemStar Pump

This manual is designed for use by healthcare professionals, caregivers, and patients. The Hospira Technical Support Operations hotline is available 24 hours a day (in the USA) to provide consultation and technical assistance regarding the Hospira GemStar Pump.

In the USA: Hospira Technical Support Operations
1-800-241-4002

Outside the USA: Contact your local Hospira sales office

To order additional copies of this manual (List 13981) call Hospira Customer Care:
1-877-9HOSPIRA
(1-877-946-7747)

Hospira GemStar Manual 430-00899-002 (Rev. 11/04)
## Change History

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description of Change</th>
<th>Pages Changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>430-00899-001 (Rev. 10/02)</td>
<td>Original Issue</td>
<td>N/A</td>
</tr>
<tr>
<td>430-00899-A01 (Rev. 03/03)</td>
<td>Replaced power LED illustration, Aligned pencil icons, Replaced sample trumpet curve illustration</td>
<td>3, 16, 95</td>
</tr>
<tr>
<td></td>
<td>Updated trademark information and copyright date; replaced symbol of exclamation point inside triangle</td>
<td>122</td>
</tr>
<tr>
<td>430-00899-002 (Rev. 11/04)</td>
<td>Second Release</td>
<td>Inclusive</td>
</tr>
<tr>
<td>430-00899-A02 (Rev. 02/05)</td>
<td>Updated Change History, Updated part number and revision in footer, Corrected typographical error in note, Updated copyright and CSA information, Moved dashed line and scissor icon away from binding edge, Added UL/CSA information</td>
<td>ii, 73–76, 119, front and back covers, 126, 119</td>
</tr>
</tbody>
</table>

*Note: Change page manuals assembled by Hospira include a change page identifier in the part number on the cover page and on the bottom of each changed page. This change page manual is identified as 430-00899-A02.*
# Contents

## 1. Introduction

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Pump Layout</td>
<td>2</td>
</tr>
<tr>
<td>GemStar Pump Components</td>
<td>4</td>
</tr>
<tr>
<td>GemStar Pump Features</td>
<td>5</td>
</tr>
<tr>
<td>Menu System</td>
<td>6</td>
</tr>
<tr>
<td>Operating Modes</td>
<td>7</td>
</tr>
<tr>
<td>Indications for Use</td>
<td>8</td>
</tr>
<tr>
<td>Contraindications for Use</td>
<td>9</td>
</tr>
<tr>
<td>Warnings and Cautions</td>
<td>9</td>
</tr>
</tbody>
</table>

## 2. Basic Operation

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>15</td>
</tr>
<tr>
<td>Selecting a Power Source</td>
<td>16</td>
</tr>
<tr>
<td>Connecting to the GemStar Docking Station</td>
<td>21</td>
</tr>
<tr>
<td>Powering On the Pump</td>
<td>22</td>
</tr>
<tr>
<td>Accessing the Delivery Mode Menu</td>
<td>24</td>
</tr>
<tr>
<td>Programming the Pump</td>
<td>25</td>
</tr>
<tr>
<td>Starting a New Container</td>
<td>27</td>
</tr>
<tr>
<td>GemStar Pump Set</td>
<td>27</td>
</tr>
<tr>
<td>Loading the Cassette</td>
<td>30</td>
</tr>
<tr>
<td>Releasing the Cassette</td>
<td>31</td>
</tr>
<tr>
<td>Priming a GemStar Pump Set</td>
<td>32</td>
</tr>
</tbody>
</table>

## 3. Pain Management

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Therapy Features and Specifications</td>
<td>41</td>
</tr>
<tr>
<td>Pain Management Programming</td>
<td>42</td>
</tr>
<tr>
<td>Bolus Delivery</td>
<td>44</td>
</tr>
<tr>
<td>Loading Dose Delivery</td>
<td>45</td>
</tr>
<tr>
<td>Changing a Pain Management Program</td>
<td>46</td>
</tr>
<tr>
<td>Pain Management Programming Worksheet</td>
<td>48</td>
</tr>
</tbody>
</table>
Contents

4. Options Menu 49
   - Overview ................................................................. 49
   - Tips for Using the Options Menu .............................. 49
   - Review Program .................................................. 51
   - Histories ............................................................... 51
   - Keypad Lock ............................................................ 56
   - Change Pump Settings ............................................. 58
   - Set Clock ............................................................... 60
   - Print ................................................................. 61
   - Speed Protocol .......................................................... 62
   - Connecting to the Data Port ..................................... 64
   - Transferring Data Using a Computer ......................... 69

5. Clinician Instructions 73
   - Clinician Locking Sequence Instructions .................. 74
   - Program and Deliver a Clinician Activated Loading Dose .... 75
   - Shift Totals and History .......................................... 76

6. Troubleshooting 77
   - Alarm Messages .................................................... 78
   - Alert Messages ..................................................... 85
   - Other Display Messages ............................................ 88

7. Maintenance 89
   - Pump Storage ............................................................ 89
   - Cleaning and Disinfecting ......................................... 89
   - Repair ................................................................. 91

8. Operation Test 93
   - Equipment Required ................................................. 93
   - Test Setup ............................................................ 94
   - Performing the Operation Test .................................... 94
   - Printing Test Results .............................................. 99
   - Operation Test Checklist ........................................... 101
Contents

9. Optional System Components ........................................... 103
   Connecting the Bolus Cord .............................................. 106
   Using the GemStar Lockboxes ......................................... 106
   Using the Hospira Carrying Cases .................................... 109
   Using the GemStar Docking Station .................................. 115

10. Pump Sets ........................................................................... 117

11. GemStar Pump Specifications .................................................. 119
    Occlusion Information ..................................................... 122

12. Warranty/Technical Assistance ................................................... 137

Index ......................................................................................... 139

IEC Symbols inside back cover
Chapter 1
Introduction

The GemStar® Pain Management Pump is a small and lightweight, single-channel infusion device designed for use in the home, in the hospital, or anywhere electronic infusion is required. The GemStar Pump can be powered by AC mains adaptor, rechargeable battery pack, docking station, or two disposable AA alkaline or lithium batteries. When powered by batteries, the GemStar Pump is ideal for ambulatory patients.

The following conventions are used throughout this manual:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Use</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL CAPS</td>
<td>Display messages</td>
<td>The pump displays: ENTER TO CONFIRM.</td>
</tr>
</tbody>
</table>

**WARNING:** A WARNING message contains special safety information and must be observed at all times. Failure to observe a warning message could be life threatening.

**CAUTION:** A CAUTION contains information that could prevent irreversible product damage or hardware failure. Failure to observe a caution could result in serious patient or user injury.

Note: A NOTE contains information or examples to help explain instructions.

Tip: A TIP contains information that makes the pump easier to use.

Note: Examples are provided only to help explain a pump function and may not be clinically relevant. Graphics are for illustrative purposes only and may not reflect the actual product.
1. Introduction

GemStar Pump Layout

Shown approximate size
1. Introduction

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 DISPLAY</td>
<td>Displays the pump’s status.</td>
</tr>
<tr>
<td>2 SILENCE</td>
<td>Silences an alarm.</td>
</tr>
<tr>
<td>3 STOP</td>
<td>Stops infusion.</td>
</tr>
<tr>
<td>4 START</td>
<td>Starts infusion.</td>
</tr>
<tr>
<td>5 POWER Indicator</td>
<td>Lights continuously when the pump is powered by AC mains. Flashes when the pump is powered by external batteries (e.g., battery pack). Not lit when using disposable AA batteries.</td>
</tr>
<tr>
<td>6 BACK-UP</td>
<td>Powers the pump on or off. To power-off the pump, press and hold until the display clears.</td>
</tr>
<tr>
<td>7 CHANGE</td>
<td>Returns to previous steps during programming. Exits Help, Change, and Options menus.</td>
</tr>
<tr>
<td>8 OPTIONS</td>
<td>Displays the following menu items from the STOP or RUN mode*: New Container, Change Program, New Program, Resets a numeric value to zero.</td>
</tr>
<tr>
<td>9 OPTIONS</td>
<td>Displays the following Options Menu items from the STOP or RUN mode*: Review Program, Set Clock, Histories, Print, Keypad Lock, Speed Protocol, Pump Settings.</td>
</tr>
<tr>
<td>10</td>
<td>Scrolls through display messages. Toggles between AM and PM in time-based entries. UP arrow enters a decimal point in numeric entries. DOWN arrow toggles between units of measure when entering concentrations.</td>
</tr>
<tr>
<td>11 YES</td>
<td>Responds “YES” to display questions. Accepts entries and goes to the next step.</td>
</tr>
<tr>
<td>12 NO</td>
<td>Responds “NO” to display questions.</td>
</tr>
<tr>
<td>13 HELP</td>
<td>Displays information during programming steps and alarm conditions. Displays Shift Totals, except during programming steps and alarm conditions.</td>
</tr>
<tr>
<td>14 PURGE</td>
<td>Clears an AIR-IN-LINE alarm. Primes a Gemstar Pump Set.</td>
</tr>
<tr>
<td>15 [0]-[9]</td>
<td>Selects menu items and enters numeric values. If two numbers appear before a menu item (e.g., 02), press both number keys to select that item.</td>
</tr>
</tbody>
</table>

* Not all menu items are available with all modes.
1. Introduction

GemStar Pump Components

1. Bolus Button
   Press this button to start a bolus delivery if available in the current program.

2. Pole Clamp Track
   Use to connect to an optional pole clamp.

3. Cassette Release Button
   Push down on this button to release the cassette.

4. Power Connector
   Use to connect the AC mains adaptor.

5. Data Port Connector
   Use to connect the GemStar serial cable.

6. Bolus Connector
   Use to connect a bolus cord.

7. Tubing Channel
   Place the pump set tubing in this channel.

8. Cassette Pocket
   Load the cassette into this pocket.

9. I.V. Tubing Guide
   Use to hold the I.V. tubing.

10. Battery Pack Connector
    Use to connect the GemStar Rechargeable Battery Pack.

11. Battery Compartment
    Install two fresh, disposable AA batteries in this compartment.
1. Introduction

GemStar Pump Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Reference Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Adjustable Settings</td>
<td>Adjusts the distal occlusion pressure limits, air sensor sensitivity, real-time clock, and audible alarm volume.</td>
<td>Chapter 4 Options Menu</td>
</tr>
<tr>
<td>• Alerts and Alarms</td>
<td>Signals audible and visual alarms when attention is required.</td>
<td>Chapter 6 Troubleshooting</td>
</tr>
<tr>
<td>• Audible Keypad Response</td>
<td>Sounds a single beep when any key is pressed. If an invalid key is pressed, the pump sounds a flutter tone.</td>
<td>Chapter 1 Introduction, GemStar Pump Layout</td>
</tr>
<tr>
<td>• Keypad Lock</td>
<td>Restricts access to various options. Four lock levels are available.</td>
<td>Chapter 4 Options Menu and Chapter 5 Clinician Instructions</td>
</tr>
<tr>
<td>• New Container</td>
<td>Repeats the current program without reprogramming the pump.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td>• Power-on Self-test</td>
<td>Performs a self-test each time the pump is powered on.</td>
<td>Chapter 2 Basic Operation</td>
</tr>
<tr>
<td>• Operation Test</td>
<td>Performs user-assisted tests to verify the pump is operating properly.</td>
<td>Chapter 8 Operation Test</td>
</tr>
<tr>
<td>• Program History</td>
<td>Maintains a history event log, with a date and time stamp of each event for each program. Review the history on the display, or download it to a printer or computer.</td>
<td>Chapter 4 Options Menu</td>
</tr>
<tr>
<td>• Speed Protocols</td>
<td>Stores up to nine frequently used programs in the pump’s memory for quick access.</td>
<td>Chapter 4 Options Menu</td>
</tr>
</tbody>
</table>
# 1. Introduction

## Menu System

The GemStar Pump uses a menu system that provides step-by-step instructions through all of the pump’s functions. Refer to the following table for a list of functions in each menu.

Use the keypad to select menu items, respond to display messages, and enter numeric values. For example, press `[2]` to select `HISTORIES` from the Options Menu.

*Note: Menu items may vary depending on the pump’s configuration.*

**Tip:** A menu item does not have to be on the display to be selected. For example, when the Options Menu first displays, only the first four menu items are shown. Instead of pressing the down arrow to see the other menu items, press `[5]` to go directly to `SET CLOCK`.

<table>
<thead>
<tr>
<th>To display this menu:</th>
<th>Do this:</th>
<th>Menu Items Available</th>
</tr>
</thead>
</table>
| **Delivery Mode Menu**      | 1 Press `CHANGE` to display the Change menu.  
2 Select `NEW PROGRAM`.  | 1 CONTINUOUS  
2 BOLUS  
3 CONT + BOLUS |
| **Change Menu**             | Press `CHANGE`.             | 1 NEW CONTAINER  
2 NEW PROGRAM  
3 CHANGE PROGRAM |
| **Options Menu**            | Press `OPTIONS`.            | 1 REVIEW PROGRAM  
2 HISTORIES  
3 KEYPAD LOCK  
4 PUMP SETTINGS  
5 SET CLOCK  
6 PRINT  
7 SPEED PROTOCOL |
1. Introduction

<table>
<thead>
<tr>
<th>For more information on:</th>
<th>Refer to the following pages:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery Mode Menu</td>
<td>Chapter 3 Pain Management, page 41.</td>
</tr>
<tr>
<td>Change Menu</td>
<td>For menu item [1], refer to Starting a New Container in Chapter 2 Basic Operation, on page 27. For menu items [2] and [3], refer to Chapter 3 Pain Management, page 41.</td>
</tr>
<tr>
<td>Options Menu</td>
<td>Chapter 4 Options Menu, page 49.</td>
</tr>
</tbody>
</table>

Operating Modes

The GemStar Pump has four operating modes:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Mode</td>
<td>The pump enters the HELP mode when HELP is pressed during programming or an alarm condition. The HELP mode displays additional information about the current condition.</td>
</tr>
<tr>
<td>Programming Mode</td>
<td>The pump enters the PROGRAMMING mode after the pump is powered on or when CHANGE is pressed.</td>
</tr>
<tr>
<td>Run Mode</td>
<td>After STOP is pressed, the pump enters the RUN mode, even when not infusing.</td>
</tr>
<tr>
<td>Stop Mode</td>
<td>When programming is complete, the pump enters the STOP mode until STOP is pressed.</td>
</tr>
<tr>
<td></td>
<td>When the programmed therapy is complete, and during certain alarm conditions, the pump automatically enters the STOP mode.</td>
</tr>
<tr>
<td></td>
<td>Press STOP to enter the STOP mode at any time, except during a CHECK CASSETTE alarm.</td>
</tr>
</tbody>
</table>
1. Introduction

Indications for Use

Physicians or certified, licensed healthcare professionals should always oversee infusions. Healthcare professionals should always supervise pump users and instruct users in pump operation and troubleshooting. Instruction should include how to prevent intravenous (I.V.) related complications, including how to prevent accidental infusion of air.

The pump is suitable for intravenous, arterial, subcutaneous, short-term epidural infusion of general I.V. fluids and medications. The epidural route is recommended to provide anesthesia or administer analgesia for periods up to 96 hours.

Note: Epidural administration of anesthetics is recommended in the continuous mode only. Epidural administration of analgesics may be delivered by continuous, bolus, or continuous with bolus.

For epidural use, the administration of drugs is restricted to those anesthetic and analgesic drugs approved for continuous epidural administration: e.g., Chloroprocaine Hydrochloride USP, Lidocaine Hydrochloride USP, and Morphine Sulfate Injection USP (Preservative Free).

**WARNING:** Delayed respiratory depression following continuous epidural administration of preservative-free morphine sulfate has been reported.

For epidural administration, the following is recommended:

- Nylon or Teflon® catheter
- Pump sets without Y-sites
- Stickers for the tubing indicating ongoing administration

Note: Facilities practicing epidural anesthesia/analgesia must be staffed and equipped to manage cardio-pulmonary resuscitation (CPR). Supplies should include oxygen, naloxone, and other appropriate resuscitative drugs and equipment. Monitor patients continuously (e.g., oximetry) during epidural administration. Frequently observe patient for side effects (for up to 24 hours) following completion of drug administration by the epidural route.
1. Introduction

Contraindications for Use

Persons who do not have the mental and physical capability or the emotional stability to properly use the GemStar Pump should not operate this pump.

DO NOT use the following with the Hospira GemStar Pump System:

- Drugs not compatible with silicone rubber or PVC plastic
- Drugs not stable under infusion conditions

Warnings and Cautions

Pay attention to the following warnings and cautions when operating the Hospira GemStar Pump. These warnings and cautions are repeated in the manual when relevant to the procedure being discussed. Pay attention to all alert messages.

General Warnings and Cautions

- Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.
- Manual references to specific values are approximate only, unless indicated otherwise. Air-in-line sensitivity values are approximate only.
- When a Proximal Occlusion alarm activates, DO NOT power-off the pump.
- Closely supervise patients who are likely to be adversely affected by unintended operations and failures, including interrupted medication or fluid infusion. Ensure provisions for immediate corrective action are available.

Regarding Drugs Used, Pump Sets, and Containers

- USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.
- NEVER use drugs that are incompatible with silicone rubber or PVC plastic.
- To reduce the loss of potency for drugs known to be absorbed by PVC plastic and silicone, begin infusion as soon as practical after priming the pump set. Use of high flow rates during infusion will minimize drug absorption.
1. Introduction

- DO NOT use medications that are unstable under infusion conditions.
- ALWAYS use connections with Luer Lock™ fittings.
- To prevent contamination, use aseptic technique with all fluid-path connections. Remove the protective coverings as assembly progresses.
- ALWAYS place the flow stop in the closed position when the set is not in the pump.
- Make sure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.
- Ensure the tubing is behind the tubing guide (at the distal end).
- Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.
- NEVER use vented fluid containers (e.g., glass or rigid plastic) unless suspended from a pole.
- Stop infusion if signs or symptoms of infiltration occur.
- GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
- Failure to use the anti-siphon valve may result in unrestricted flow.
- ALWAYS close the slide clamps before removing the cassette from the pump.
- When using pre-filled vials, the system may underdeliver at low flow rates.

Regarding Air-In-Line and Infusion

- To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.
- ALWAYS prime the pump set to remove all air from the cassette, tubing, and injection site prior to connecting to the patient.
- ALWAYS disconnect the pump set from the patient prior to priming or purging.

Regarding Pump Operation

- If the pump does not perform as stated in this manual, remove the pump from service IMMEDIATELY.
- If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.
1. Introduction

- Ensure a cassette is installed in the pump before connecting to a printer or computer. **If the pump is connected to a patient:** BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.
- Disconnect the pump from the patient BEFORE performing the Operation Test.
- ALWAYS connect to a grounded AC mains power source when using AC mains power. If the quality of the grounding source is in doubt, operate the pump only with batteries.
- USE ONLY the AC mains adaptors specifically labeled for use with the GemStar Pump.
- Use ONLY the AC mains adaptor specifically labeled for use with the GemStar Pump to charge the battery pack.
- The GemStar AC Mains Adaptor is for use with the GemStar Pump or GemStar Rechargeable Battery Pack only. DO NOT use the GemStar AC mains adaptor with other products.
- During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug the AC mains adaptor and contact Hospira Technical Support Operations.
- When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.
- To ensure proper pump operation, ALWAYS replace BOTH disposable batteries with fresh, disposable AA batteries when a change is required.
- ALWAYS fully close the battery door when using disposable batteries.
- DO NOT use rechargeable batteries in the battery compartment.
- Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., docking station, battery pack). The pump will continue to operate on backup power if the external power source fails.
- ALWAYS avoid sources of high-intensity electromagnetic radiation (e.g., radio transmitters, MRI scanners, microwave ovens, X-ray machines, and CAT scanners).
- Use of radio-frequency emitting devices, such as cellular telephones, 2-way radios, and Electrical Surgical Devices (ESU), in close proximity to this device may affect its operation.
1. Introduction

- Possible explosion hazard exists if the pump is used in the presence of flammable anesthetics. NEVER use the pump in the presence of flammable or explosive vapors.

- Non-hazardous, low-level electrical potentials are commonly observed when fluids are administered using infusion devices. These potentials are well within accepted safety standards, but may create artifacts on voltage-sensing equipment, such as ECG, EMG, and EEG machines. These artifacts vary at a rate that is associated with the infusion rate. If the monitoring machine is not operating correctly or has loose or defective connections to its sensing electrodes, these artifacts may be accentuated so as to simulate actual physiological signals. To determine if the abnormality in the monitoring equipment is caused by the infusion device instead of some other source in the environment, set the infusion device so that it is temporarily not delivering fluid (if clinically acceptable). Disappearance of the abnormality indicates that it was probably caused by electronic noise generated by the infusion device. Proper setup and maintenance of the monitoring equipment should eliminate the artifact. Refer to the appropriate monitoring system documentation for setup and maintenance instructions.

- The GemStar pump, when connected to the GemStar AC adaptor, has been tested and found to comply with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (2001). When connected to other power sources and/or optional system components, the GemStar system complies with EMC/EMI limits in accordance with IEC/EN 60601-1-2 (1993). These limits are designed to provide reasonable protection against harmful interference in a typical medical installation. The equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to other devices in the vicinity. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference with other devices, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
  - Reorient or relocate the receiving device
  - Increase the separation between the equipment
  - Connect the equipment to an outlet on a circuit different from that to which the other device is connected
  - Consult the manufacturer or field service technician for help
  - The use of portable and mobile RF equipment may have an impact on this and other pieces of medical equipment
1. Introduction

Regarding Handling and Maintenance

- Use proper care during unpacking, installation, and operation of the pump. If the pump is inadvertently mishandled, check connections and programmed data to ensure there is no damage. Refer to Chapter 8 Operation Test for further information.

- ALWAYS avoid dropping or hitting the pump. If the pump is dropped or hit, ALWAYS check connections and programmed data.

- NEVER use sharp objects (e.g., fingernails, pens, pencils, or other probes) to program or clean the pump.

- Use care not to damage the silicone seals around the sensor bodies in the cassette pocket.

- To avoid mechanical or electronic damage, NEVER submerge pump in water or other fluids and avoid fluid spills. If the pump becomes wet, dry it immediately with a dry, lint-free cloth. Check connections and programmed data.

- Some cleaning and sanitizing compounds may slowly degrade components made from some plastic materials. DO NOT use compounds containing combinations of isopropyl alcohol and dimethyl benzyl ammonium chloride (i.e., alcohol wipes).

- DO NOT sterilize by heat, steam, ethylene oxide (ETO), or radiation. Apply disinfectants to the outside surface of the pump only. DO NOT use abrasive cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions not recommended by Hospira may result in product damage.

- Please comply with local disposal and recycling regulations as appropriate for disposable batteries, rechargeable battery packs, medical electronic components, and pump sets.
Chapter 2

Basic Operation

The minimum elements required for using the GemStar Pump are:

- GemStar Pump
- Appropriate power source
- Appropriate GemStar Pump Set
- Appropriate fluid container
- Patient-access device

Overview

To start a therapy:

1. Determine the program settings. Refer to Chapter 3 Pain Management for a worksheet that may be copied and used to record program settings.
2. Select a power source. Refer to Selecting a Power Source on page 16.
3. Prime the pump set. Refer to GemStar Pump Set on page 27.
4. Load the cassette into the pump. Refer to Loading the Cassette on page 30.
5. Power-on the pump and go to the Delivery Mode Menu. Refer to Powering On the Pump on page 22.
6. Select the appropriate optional system components, such as a bolus cord.
7. Select the delivery mode and enter a program. Refer to Chapter 3 Pain Management, page 41 for detailed instructions.
8. Press [START] to begin delivery.
## 2. Basic Operation

### Selecting a Power Source

The GemStar Pump may be powered by one or more of the following:

<table>
<thead>
<tr>
<th>Power Source</th>
<th>Description</th>
<th>Ambulatory</th>
<th>Hospital</th>
<th>Home</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar AC Mains Adaptor</td>
<td>Wall-mount adaptor plugs into a 110 VAC mains supply.</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>(USA)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GemStar AC Mains Adaptor</td>
<td>Tabletop adaptor plugs into a 100–240 VAC mains supply.</td>
<td>•</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>(Universal)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GemStar Docking Station</td>
<td>Plugs into a 100–240 VAC Volt mains supply while mounted on an I.V. pole.</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td></td>
<td>The docking station’s internal batteries power the GemStar Pump during periods of transport.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GemStar Battery Pack</td>
<td>The battery pack's internal batteries power the GemStar Pump during periods of transport or when use of AC power is not desirable.</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Disposable Batteries</td>
<td>Two disposable AA alkaline or lithium batteries (available from local sources)</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

**CAUTION:** To ensure proper pump operation, ALWAYS replace BOTH batteries with fresh, disposable AA batteries when a change is required.

DO NOT use rechargeable batteries in the battery compartment.

Ensure two fresh, disposable AA batteries are installed for backup power when using other power sources (e.g., docking station, battery pack). The pump will continue to operate on backup power if the external power source fails.
2. Basic Operation

**Installing Disposable Batteries**

1. Flip open the tab of the battery door on the bottom of the pump.
2. With the pump keypad facing up, hold onto the tab and turn the battery door to the left (counterclockwise) until it is released from the battery compartment.
3. Pull the door free and remove any existing batteries.
4. Install two fresh, disposable AA batteries into the battery compartment. Ensure the batteries are inserted as shown.
5. Return the battery door to the battery compartment.
6. Turn the battery door to the right (clockwise). Ensure the battery door is secured under the slot.
7. Flip closed the tab of the battery door to lock in place.
2. Basic Operation

Connecting the GemStar AC Mains Adaptor

1. Connect the cord of the AC mains adaptor to the connector labeled “3 VDC” on the bottom of the pump.

2. Plug the AC mains adaptor into a standard wall outlet.

CAUTION: ALWAYS connect to a grounded AC mains power source when using the AC mains adaptor. USE ONLY AC mains adaptors specifically labeled for use with the GemStar Pump.

When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Note: The green LED on the pump remains lit when connected to AC mains power.
2. Basic Operation

Using the GemStar Rechargeable Battery Pack

Use the GemStar AC Mains Adaptor (List 13026-01 [USA] or 13072-01 [Universal]) to recharge the GemStar Battery Pack.

CAUTION: ALWAYS connect to a grounded AC mains outlet when using AC mains adaptor. Use only AC mains adaptors specifically labeled for use with the GemStar Pump to charge the battery pack. During charging, the battery pack is warm. If the battery pack becomes hot to the touch, IMMEDIATELY unplug AC mains power and contact Hospira Technical Support Operations.

Note: A charged battery pack will last approximately 24 hours when the pump is infusing at rates less than 125 mL/hr.

To connect the battery pack:
1. Line up the connectors on the top of the battery pack with the holes on the bottom of the pump.
2. Snap the battery pack into place.

To release the battery pack:
1. Press the release button on the battery pack.
2. Pull the battery pack straight out from the pump.

Note: When the pump is connected to the battery pack, the pump’s green LED flashes and the battery pack light is off.

When the pump is connected to the battery pack at power-on, the pump displays USING EXT BATT.
2. Basic Operation

To recharge the battery pack:

1. Plug the pin connector of the AC mains adaptor into the port on the bottom of the battery pack.
2. Plug the AC mains adaptor into a standard wall outlet.
3. Leave the battery pack connected to the AC mains adaptor for at least 8 hours to recharge the battery pack.

CAUTION: When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

Note: The battery pack light is yellow while the battery pack is charging. When the battery pack is charged, the battery pack light is green.
2. Basic Operation

Connecting to the GemStar Docking Station

Connecting the Pump

1. Mount the docking station to the I.V. pole and tighten the knob.
2. Line up the connectors on the bottom of the pump with the connectors on the docking station.
3. Slide the pump into the docking station until it snaps into place.
4. Connect the docking station to AC mains power.

*Note: The docking station light is yellow while the docking station is charging. When the docking station is charged, the light is green.*

Disconnecting the Pump

To remove the pump:

1. Press the release button on the top of the docking station.
2. Slide the pump out.
2. Basic Operation

Powering On the Pump

**CAUTION:** If the pump does not display the self-test or if beeps do not sound at power-on, check all power connections and install two fresh, disposable AA batteries. If the problem continues, contact Hospira Technical Support Operations before using the pump.

*Note: If a cassette is not properly loaded, the pump will alarm after the power-on test is complete.*

1. Press [ON/OFF] to power-on the pump. The pump completes a self-test and displays the time and date. No response is required.

2. The pump checks for available power sources. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>No message displays</td>
<td>AC power and disposable batteries.</td>
<td>No response required, the pump goes to the next step.</td>
</tr>
<tr>
<td>LOW BATTERIES ENTER TO CONFIRM</td>
<td>AC power and weak (low voltage) disposable batteries; or weak disposable batteries only.</td>
<td>Press [CONFIRM] to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
<tr>
<td>NO INTERNAL BATT NO POWER LOSS ALARM AVAILABLE ENTER TO CONFIRM</td>
<td>No disposable batteries or dead disposable batteries; and external power.</td>
<td>Press [CONFIRM] to confirm. Power-off the pump and install two fresh, disposable AA batteries as a backup power source.</td>
</tr>
</tbody>
</table>
2. Basic Operation

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Power Source(s)</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>USING BATTERIES</td>
<td>Disposable batteries only.</td>
<td>Press ENTER to confirm.</td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td></td>
<td>If an external power source is in use,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ensure the connections are secure.</td>
</tr>
<tr>
<td>USING EXT BATT</td>
<td>External batteries (docking station battery or battery pack) and disposable batteries.</td>
<td>Press ENTER to confirm.</td>
</tr>
<tr>
<td>ENTER TO CONFIRM</td>
<td></td>
<td>If an AC mains adaptor is in use,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ensure the connections are secure.</td>
</tr>
</tbody>
</table>

Note: To power-off the pump, press and hold until the display clears. The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 6 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

For more information on:

- Setting the clock
  - Set Clock in Chapter 4 Options Menu, on page 60.
- Locking the keypad
  - Keypad Lock in Chapter 4 Options Menu, on page 56.
2. Basic Operation

## Accessing the Delivery Mode Menu

After power-on, the pump checks its memory for a stored program. Respond to the display message as shown in the following table:

<table>
<thead>
<tr>
<th>Display Message</th>
<th>Condition</th>
<th>User Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>The pump displays the Delivery Mode Menu.</td>
<td>Pump memory is clear.</td>
<td>▶ To enter a new program: Select a delivery mode from the Delivery Mode Menu and enter a new program. Refer to Chapter 3 Pain Management for instructions.</td>
</tr>
</tbody>
</table>
| 1 RESUME PROGRAM 2 CLR PROG&SHIFT 3 CLR PROG,SHIFT AND HISTORY | A program is currently stored in pump memory. | ▶ To continue the current program, press [1]. ▶ To reset the current program:  
1 Press [1].  
2 Press [CHANGE] to display the Change Menu and select NEW CONTAINER. ▶ To enter a new program and clear shift totals: Press [2]. The pump clears the program and shift totals from memory and enters PROGRAMMING mode. ▶ To enter a new program, clear shift totals, and clear history: Press [3]. The pump clears the program, shift totals, and history from memory and enters PROGRAMMING mode. |

Tip: To enter a new program when the pump is already powered on:

1. Press [STOP] to place the pump in STOP mode.
2. Press [CHANGE] to display the Change Menu.
3. Select NEW PROGRAM. The pump clears the current program and displays the Delivery Mode Menu.
2. Basic Operation

Programming the Pump

Programming Overview

The pump’s menu system provides step-by-step guidance through all of the programming steps. Refer to Chapter 3 Pain Management for detailed programming instructions.

A programming worksheet is available at the end of Chapter 3 that lists the minimum and maximum value (program range) allowed for a Pain Management therapy. If a number outside of the program range is entered, the pump displays the minimum or maximum value allowed.

1 Select the desired delivery mode from the Delivery Mode Menu.

2 Respond to display messages and enter requested values.

   Note: Program entries can be changed any time before the Program Review is complete. Press [BACK-UP] to return to previous program displays and make changes as desired.

3 Review the program, if required. Press ▼ to begin review. Press [YES/ENTER] when done.

4 SAVING PROGRAM displays. The pump stores the program in memory and then enters STOP mode.

   Tip: If you enter an incorrect number during programming, press [CHANGE] BEFORE pressing [YES/ENTER] to reset the number to zero. Then enter the correct number.
2. Basic Operation

**Programming Tips**

The following table explains how to use the keypad during programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Press the number keys to select menu items and to enter numeric values.</td>
</tr>
<tr>
<td>YES ENTER</td>
<td>Press YES ENTER to accept entries or to continue when done viewing a display.</td>
</tr>
<tr>
<td>HELP</td>
<td>Press HELP during programming and alarm conditions to display information about the current condition.</td>
</tr>
<tr>
<td></td>
<td>Press or to scroll through display messages.</td>
</tr>
<tr>
<td></td>
<td>Press to insert a decimal point in a numeric value.</td>
</tr>
<tr>
<td>CHANGE</td>
<td>When entering a numeric value during programming, press CHANGE before pressing YES ENTER to reset the value to zero.</td>
</tr>
<tr>
<td>BACK-UP</td>
<td>Press BACK-UP to return to a previous display, to exit the Options Menu, or to exit the HELP mode.</td>
</tr>
</tbody>
</table>
2. Basic Operation

Starting a New Container

Note: The NEW CONTAINER function is not available when the pump is in FULL Lock. Refer to Chapter 4 Options Menu, page 49 for more information on locking the keypad.

To repeat the current program with a new container:

1. From the STOP mode, press [CHANGE] to display the Change Menu.
2. Select NEW CONTAINER from the Change Menu. The pump displays NEW CONTAINER for several seconds and clears the amount infused from memory.
3. Review the program. Press ▼ to begin review.
4. Press [START] to begin delivery.

GemStar Pump Set

The GemStar Pump Set is a sterile, single-use, disposable pump set. It is designed for one-time use only and should be properly discarded after use.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

Contact a Hospira representative for more information on selecting the appropriate pump set configuration. Additional disposable components, such as air-eliminating filters and extension sets, may be added to the line as required. To use a GemStar Pump Set, follow the instructions included with the set.

Note: GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
2. Basic Operation

A typical GemStar Pump Set is shown below:

1. Piercing Pin
2. Proximal End
3. Cassette
4. Flow Stop (open / close)
5. Distal End
6. Tubing
7. Slide Clamp
8. Secure Lock
9. Anti-Siphon valve
2. Basic Operation

**WARNING:** ALWAYS prime the pump set to remove air from the cassette, tubing, and injection sites prior to connecting to the patient. **ALWAYS** disconnect the pump set from the patient prior to priming or purging. Arrange tubing, cords, and cables to minimize the risk of patient strangulation or entanglement.

Failure to use the anti-siphon valve may result in unrestricted flow.

**CAUTION:** USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

To prevent contamination, use aseptic technique with all fluid-path connections. Remove protective coverings as assembly progresses.

**Opening the Pump Set**

1. Open the GemStar Pump Set package and remove the contents.

2. Remove the protective covers from the fluid container administration port and the pump set.
2. Basic Operation

Loading the Cassette

1. Identify the four black cassette latches inside the cassette pocket.

2. Line up the cassette as shown (with the flow stop button facing the pump).

3. Insert the cassette into the cassette pocket by pushing firmly along the entire cassette until it is firmly seated.
2. Basic Operation

4 Verify that all four cassette latches are securely holding the cassette.

![Cassette Latches Diagram]

**CAUTION:** Ensure the cassette is properly installed. When properly installed, all four cassette latches are visibly holding the cassette securely in the cassette pocket.

5 Place the tubing in the tubing channel.

![Tubing Guide Diagram]

**Note:** Ensure the tubing is behind the tubing guide (at the distal end).

**Note:** The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode). Refer to Chapter 6 Troubleshooting for information on clearing a CHECK CASSETTE alarm.

---

**Releasing the Cassette**

1 Close the slide clamp on the distal line.

![Slide Clamp Image]

2 Push down on the cassette release (large black button) on the top of the pump.

![Cassette Release Image]

3 Remove the cassette.

**Note:** When the cassette is released from the pump, the cassette flow stop automatically closes, preventing free flow.
2. Basic Operation

**Priming a GemStar Pump Set**

*Priming Pump Sets WITHOUT a Drip Chamber*

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

1. Push down on the flow stop to close the cassette.
2. Hold the container with the administration port toward the ceiling and insert the piercing pin.
3. Push down on the flow stop to open (priming position) the cassette.
4. Invert the cassette approximately 45°.
5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.
6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7 Push down on the flow stop to close the cassette.

8 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 30.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

9 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets WITHOUT a Drip Chamber Using the PURGE Key**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

*Note: The PURGE function is available only if there is a program in the pump.*

1. Push down on the flow stop to close the cassette.

2. Hold the container with the administration port toward the ceiling and insert the piercing pin.

3. Load the cassette.

4. Program desired therapy.

*CAUTION:* Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 30.

*Note: Ensure the tubing is behind the tubing guide (at the distal end).*
2. Basic Operation

5 Press [PURGE].

6 The pump displays PRIME THE SET? Press [YES/ENTER].

7 While holding the container with the administration port toward the ceiling, press and hold [PURGE].

   Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

   Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

   CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

8 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets Using Pre-filled Vials**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

**CAUTION:** When using pre-filled vials, the system may underdeliver at low flow rates.

1. If using a pump set with the Y-extension, use the slide clamp to close off the KVO (Keep Vein Open) side of the tubing.

2. Open the upper and lower slide clamps.

3. Push down on the flow stop to close the cassette.

4. Connect the pump set to a Hospira pre-filled vial and injector.

5. Push down on the flow stop to open (priming position) the cassette.
2. Basic Operation

6 Hold the vial and set upright (vertically) on a flat surface with the pump set extending from the top.

7 Slowly push down on the injector until fluid flows at the distal end of the tubing, which indicates that all air is cleared from the vial, injector, cassette, and tubing.

8 Push down on the flow stop to close the cassette.

9 If the set includes a KVO Y-extension, close the slide clamp below the pre-filled vial and open the slide clamp on the KVO side. Prime the KVO Y-extension.

10 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 30.
2. Basic Operation

Note: Ensure the tubing is behind the tubing guide (at the distal end).

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

11 Connect the pump set to the patient-access device.
2. Basic Operation

**Priming Pump Sets with Extensions**

**WARNING:** Failure to use the anti-siphon valve may result in unrestricted flow.

1. Push down on the flow stop \( \varnothing \) to close the cassette.

2. Hold the container with the administrative port toward the ceiling and insert the piercing pin.

3. Push down on the flow stop \( \varnothing \) to open (priming position) the cassette.

4. Invert the cassette approximately 45°.

5. While holding the rotated cassette, squeeze or roll the container to remove air from the container and cassette.

6. Return the cassette to the upright position. Continue priming until fluid fills the tubing.
2. Basic Operation

7 Push down on the flow stop to close the cassette.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

8 Connect the extension set to the pump set.

9 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 30.

10 Program the desired therapy.

11 Press [PURGE].

12 The pump displays PRIME THE SET? Press [YES/ENTER].

13 Press and hold [PURGE].

Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE].

Continue using the [PURGE] key until fluid fills the tubing. Ensure all air is removed from the container, cassette, and tubing.

CAUTION: When priming is complete, ensure no fluid flows at the distal end of the pump set. If flow is observed, DO NOT use the pump set.

14 Connect the pump set to the patient-access device.
Chapter 3

Pain Management

Therapy Features and Specifications

This therapy allows programming of a continuous only, bolus only, or continuous with bolus delivery.

- In Continuous + Bolus protocols, you can enter zero for either the continuous rate or the bolus dose when entering or changing a program. The continuous rate and bolus dose cannot be zero at the same time.
- The default bolus delivery rate is 125 mL/hr.
- A loading dose may be set during programming, which can be delivered after programming and priming are complete. The default loading dose rate is 125 mL/hr.
- Priming using [PURGE] is only allowed before [START] is pressed or after one of the following events occur:
  - Complete Review of New Program
  - New Container
  - Air-in-Line Alarm

CAUTION: When using pre-filled vials, the system may underdeliver at low flow rates.

Note: New Container is allowed only when at least 1/2 of the container volume has been infused or 1 hour has elapsed since starting the infusion.

The use of a lockbox is recommended with pain management protocols. Refer to Chapter 9 Optional System Components, page 103, for instructions on using a lockbox with the GemStar Pump.

Tip: The Programming Worksheet at the end of this chapter lists the minimum and maximum values allowed for this protocol. Use copies of the programming worksheet to record program values before programming the pump.
3. Pain Management

**Pain Management Programming Tips**

The following table explains how to use the keypad during pain management programming:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[0] - [9]</td>
<td>Selects menu items and enters numeric values.</td>
<td>▲ ▼</td>
<td>Scrolls through program review and help messages. The up arrow inserts a decimal point in a numeric value. The down arrow toggles units of measure when entering concentrations.</td>
</tr>
<tr>
<td>YES ENTER</td>
<td>Accepts entries or continues when done viewing a display.</td>
<td>CHANGE</td>
<td>Clears a numeric value (resets to zero) during programming.</td>
</tr>
<tr>
<td>HELP</td>
<td>Displays information during programming and alarm conditions.</td>
<td>BACK-UP</td>
<td>Returns to a previous display, exits the Options Menu, and exits the HELP mode.</td>
</tr>
</tbody>
</table>

**Pain Management Programming.**

1. Select the delivery mode from the Delivery Mode Menu.

   *Note: If Continuous + Bolus is selected, the continuous delivery rate or bolus dose can be set to zero through the CHANGE menu without reprogramming the pump.*

2. Select the unit of measure and concentration as required.
3. Pain Management

3 Set the continuous delivery rate.

Note: The pump only delivers in increments of 0.1 mL. Values entered in a Pain Management therapy may be rounded to the nearest 0.1 mL. For example, at a concentration of 15 mg/mL, a rate of 5 mg rounds to 4.5 mg.

\[
5 \text{ mg} = 0.333 \text{ mL} \\
4.5 \text{ mg} = 0.3 \text{ mL}
\]

When a value is rounded, the pump sounds four quick beeps, displays Rounding for a few seconds, and then displays the rounded value. Press [YES/ENTER] to accept the rounded value and continue to the next step.

4 Program a loading dose as required.

5 Program a bolus dose with lockout time and dose limit as required.

Regarding a 1-Hour or 4-Hour Dose Limit: The hour dose limit is the maximum volume (continuous plus bolus or bolus only amount) that can be delivered over the selected period. When the programmed dose limit is reached, the continuous delivery stops and a new bolus is not allowed. As the oldest delivery amounts age out of the 1-hour or 4-hour dose limit record, the pump accepts bolus requests or resumes continuous delivery (if programmed).

Note: If a 1-hour or 4-hour dose limit is programmed, a bolus in progress will stop when the amount infused reaches the dose limit.

Loading doses are included in a 1-hour or 4-hour dose limit. A dose limit in effect could prevent the delivery of a loading dose.

6 If programmed in units of mcg or mg, the line displaying the units flashes. Enter the container size in proper unit measure.

Note: To enter the total in mL when programming a concentration, press \( \text{mL} \) to move to the mL line. Enter the mL value when \( \text{mL} \) flashes on the display.

7 Select the air sensitivity, if required.

8 Review the program. Press \( \text{PURGE} \) to begin review.

9 If using the PURGE key to prime the pump set, press [PURGE] now.

**WARNING:** ALWAYS disconnect the pump set from the patient before priming or purging.
3. Pain Management

Bolus Delivery

Set bolus doses and delivery limits during programming. The default bolus dose delivery rate in a pain management protocol is 125 mL/hr.

A bolus cord is available for patient bolus requests. Refer to Connecting the Bolus Cord in Chapter 9 Optional System Components, on page 106, for more information.

Delivering a Bolus Dose

From the RUN mode, press either the bolus button [+ ] on the top of the pump or the button on the end of the bolus cord to begin bolus dose delivery. The pump flashes BOLUS DELIVERY on the display and the amount infused accrues as the delivery progresses.

When the bolus dose is complete, the pump does the following:

- Records the bolus request and delivery amount to the event and bolus history logs
- Adds the delivered boluses to the total bolus amount in the program amounts
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed
- Continues programmed infusion

Note: ALL bolus requests are recorded to the event and bolus history logs.

If the bolus delivery does not start, it could be locked out by one of the following conditions:

- Bolus lockout period
- Loading dose delivery in progress
- Bolus dose delivery in progress
- Bolus per-hour limit
- 1-hour or 4-hour dose limit
3. Pain Management

**Bolus Dose Interruptions**

Bolus deliveries may be interrupted by:

- Pressing [STOP]
- An alarm condition

**To continue bolus delivery after an interruption:**

1. Press [START]. The pump displays **COMPLETE BOLUS NOW?**
2. Respond as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Press this key:</th>
<th>Bolus lockout time is set to:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining bolus amount</td>
<td>[YES ENTER]</td>
<td>The time of delivery completion</td>
</tr>
<tr>
<td>Clear the undelivered bolus amount</td>
<td>[NO]</td>
<td>The time the bolus was interrupted</td>
</tr>
</tbody>
</table>

**Loading Dose Delivery**

You can set a loading dose during programming, if desired. A loading dose can be delivered after programming and priming are complete.

*Note: Loading dose amounts are included in a 1-hour or 4-hour dose limit.*

**Delivering a Loading Dose**

1. After priming and programming, press [START].
2. The pump displays **DELIVER THE LOADING DOSE NOW?** Press [YES/ENTER] to begin loading dose.

When the loading dose is complete, the pump does the following:

- Automatically begins programmed infusion
- Records the dose amount to the history log
- Resets the bolus lockout time (if applicable) and ignores other bolus requests until the lockout time has elapsed
3. Pain Management

**Loading Dose Interruptions**

Loading dose deliveries can be interrupted by:

- Pressing [STOP]
- An alarm condition

To continue a loading dose:

1. Resolve the interruption.
2. Press [START]. The pump displays COMPLETE THE LOADING DOSE?
3. Respond as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Press this key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deliver the remaining loading dose amount</td>
<td>YES ENTER</td>
</tr>
<tr>
<td>Clear the remaining loading dose amount</td>
<td>NO</td>
</tr>
</tbody>
</table>

**Changing a Pain Management Program**

<table>
<thead>
<tr>
<th>Can be changed at any time</th>
<th>Cannot be changed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery rate</td>
<td>Delivery mode</td>
</tr>
<tr>
<td>Bolus</td>
<td>Unit of measure</td>
</tr>
<tr>
<td>Bolus lockout</td>
<td>Concentration</td>
</tr>
<tr>
<td>Container size</td>
<td>Dose limit amount</td>
</tr>
<tr>
<td>Air sensitivity</td>
<td></td>
</tr>
<tr>
<td>Dose limit type</td>
<td></td>
</tr>
</tbody>
</table>

*Note: You cannot change a program when the pump is in FULL or CONTAINER Lock. With a RATE CHANGE Lock, the continuous delivery rate and bolus amount can be changed within the set ranges.

Although the delivery mode cannot be changed, if Continuous + Bolus is programmed, the continuous rate or bolus amount can be changed to zero. The minimum values set with a RATE CHANGE Lock could restrict this function.*
3. Pain Management

To change a program:

1. From the STOP mode, press [CHANGE] and select CHANGE PROGRAM.
2. As each message displays, make the desired changes or press [YES/ENTER] to accept the current setting.
3. Review the program. Press  to begin review.
4. Press [START] to begin delivery.
### GemStar®

#### Pain Management Programming Worksheet

**Parameters** | **Selections and/or Values to be Entered** | **Programmable Ranges**
--- | --- | ---
Therapy | Pain Management | N/A
Delivery Mode | Continuous, Bolus Only, Continuous + Bolus | N/A
Unit of Measure | Concentration: mg/mL, Concentration: mcg/mL | 0.1 - 100 mg/mL, 1 - 1000 mcg/mL
Continuous Rate | | 0.1 - 2500 mg/hr, 1 - 25000 mcg/hr, 0.1 - 25.0 mL/hr
Loading Dose | No, Yes Amount: | 0.1 - 2500 mg, 1 - 25000 mcg, 0.1 - 25.0 mL
Bolus Dose | | 0 - 2500 mg, 0 - 25000 mcg, 0 - 25.0 mL
Bolus Lockout | | 5 - 999 min
Optional Dose Limit | 4-hour limit Amount: | 4X rate - 400 mL, 40000 mg, 400000 mcg*
| 1-hour limit Amount: | Rate - 100 mL, 10000 mg, 100000 mcg*
| # boluses/hour Number: | 1 - 12
| No dose limit | | *For continuous plus bolus delivery.
Container Size | | 0.1 - 99999 mg, 1 - 9999000 mcg, 0.1 - 9999 mL
Air Sensitivity | On, 2 mL, Off | Alarms at approx. 0.5 mL of air, Alarms at approx. 2 mL of air, No alarm

*Note: For Bolus Only, the 1-hour or 4-hour dose limit minimum is 1 bolus dose.*
Chapter 4

Options Menu

Overview

1. Press [OPTIONS] from RUN or STOP mode.
2. Select the number key for the desired function.
3. Follow the display messages for the selected function. Refer to the appropriate description in this chapter for more information.

Note: Menu selections may vary depending on the configuration of the pump.

When the pump exits OPTIONS, the pump returns to the mode it was in when [OPTIONS] was pressed.

Tips for Using the Options Menu

The following keys are helpful when using the Options Menu:

<table>
<thead>
<tr>
<th>Keys</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>[YES]</td>
<td>Press [YES] to accept changes or to continue when done viewing a display.</td>
</tr>
<tr>
<td>[△]</td>
<td>Press the up or down arrow to scroll through long display messages or to toggle AM and PM in time-based entries.</td>
</tr>
<tr>
<td>BACK-UP</td>
<td>Press BACK-UP to return to a previous display or to exit OPTIONS.</td>
</tr>
</tbody>
</table>

Tip: A menu item does not have to be on the display to be selected. For example, only items 1 through 4 are shown when the Options Menu is first displayed. To select the Print Menu without scrolling the display, press [6].
### 4. Options Menu

<table>
<thead>
<tr>
<th>Select this item from the Options Menu:</th>
<th>To do this function:</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>REVIEW PROGRAM</td>
<td>Display the current program settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>HISTORIES</td>
<td>Display the history for the latest 400 events, shift or volume totals, bolus history (if available), or current configuration settings. Clear the history. Display the Operation Test.</td>
<td>N/A</td>
</tr>
<tr>
<td>KEYPAD LOCK</td>
<td>Lock and unlock the keypad to prevent unauthorized changes to the program.</td>
<td>The lock levels allow the clinician to restrict access to various levels of pump operation.</td>
</tr>
<tr>
<td>PUMP SETTINGS</td>
<td>Change the air sensor, occlusion sensor, and sound level settings.</td>
<td>N/A</td>
</tr>
<tr>
<td>SET CLOCK</td>
<td>Set the clock.</td>
<td>The clock can be displayed in 12-hour or 24-hour format.</td>
</tr>
<tr>
<td>PRINT</td>
<td>Print the history event log, bolus history (if available), current program settings, and speed protocols.</td>
<td>Files may be downloaded to a printer or personal computer.</td>
</tr>
<tr>
<td>SPEED PROTOCOLS</td>
<td>Assign, review/recall, and delete the stored protocols.</td>
<td>Allows up to 9 speed protocols to be saved in pump memory.</td>
</tr>
</tbody>
</table>
4. Options Menu

Review Program

1. Press [OPTIONS] and select REVIEW PROGRAM. The pump displays PROGRAM REVIEW.
2. Press ▼ to begin review.
3. Press [YES/ENTER] or [BACK-UP] when done to exit OPTIONS.

Histories

1. Press [OPTIONS] and select HISTORIES.
2. Select the number key for the desired function.
3. Complete the appropriate steps for the selected function.
### 4. Options Menu

<table>
<thead>
<tr>
<th>Select this item from the Histories Menu:</th>
<th>To do this function:</th>
<th>Display includes:</th>
</tr>
</thead>
</table>
| HISTORY                                | Display history event log of the latest 400 events. | • Current date and time  
• Date and time the program was cleared, a new container was selected, or a speed protocol was recalled  
• History event log of the latest 400 events |
| SHIFT TOTALS                           | Display or clear shift totals. | • Time and date when shift was cleared  
• Volume infused in the shift  
• Any relevant program-specific information |
| VOLUME TOTALS                          | Display volume totals. | • Amount infused  
• VTBI  
• Any relevant program-specific information |
| CONFIGURATION                          | Display pump configuration. | • Dependent upon pump configuration |
| CLEAR HISTORY                          | Clear history event log and bolus history. | • CLEARING HISTORY displays for 3 to 4 seconds |
| BOLUS HISTORY                          | Display bolus history in hourly increments for the last 48 hours. | • Current date and time  
• Number of boluses delivered  
• Number of bolus demands  
• Amount delivered through bolus delivery |
| OPERATION TEST                         | Perform user-assisted Operation Test. | • Messages that guide the user through each section of the test |

**Note:** Some menu items may not be available depending on the configuration of the pump.

**Tip:** Press and HOLD or to scroll through the history displays faster.
4. Options Menu

**History**

To display the history event log:

1. Press [OPTIONS] and select **HISTORIES**.
2. Select **HISTORY** from the Histories Menu.
3. Press ‹ or › to scroll the display.
4. Press [BACK-UP] when done to exit **OPTIONS**.

**Shift Totals**

To display the shift totals:

1. Press [OPTIONS] and select **HISTORIES**.
2. Select **SHIFT TOTALS** from the Histories Menu.
3. The shift totals display. Press ‹ or › to scroll the display.

To clear the shift totals:

1. Follow the steps for displaying shift totals.
2. At the end of the shift totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the shift totals.
   - Press [NO] to exit **OPTIONS** without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.
4. Options Menu

**Volume Totals**
To display the volume totals:
1. Press [OPTIONS] and select HISTORIES.
2. Select VOLUME TOTALS from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

To clear the volume totals:
1. Follow the steps for displaying volume totals.
2. At the end of the volume totals, the pump displays CLEAR TOTALS? YES OR NO:
   - Press [YES/ENTER] to clear the volume totals.
   - Press [NO] to exit OPTIONS without clearing the volume totals.

**Configuration**
To display the pump configuration:
1. Press [OPTIONS] and select HISTORIES.
2. Select CONFIGURATION from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

**Clear History**
To clear the history event log and bolus history:
1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY from the Histories Menu.
3. The pump display CLEARING HISTORY for 3–4 seconds before exiting OPTIONS.

Tip: Press [BACK-UP] to exit OPTIONS immediately.
4. Options Menu

**Bolus History**

To display the bolus history:

1. Press [OPTIONS] and select HISTORIES.
2. Select BOLUS HISTORY from the Histories Menu.
3. Press [BACK-UP] when done to exit OPTIONS.

Note: Bolus History is only available if the current program has a bolus programmed, or had a bolus programmed at one time. The Bolus History is maintained in hourly increments for the latest 48 hours. The Bolus History is cleared when a new program is entered, a Speed Protocol is recalled, or the History is cleared.

**Operation Test**

The Operation Test checks several pump functions to ensure the GemStar Pump is working properly. Refer to Chapter 8 Operation Test on page 93 for instructions.
4. Options Menu

Keypad Lock

1. Press [OPTIONS] and select KEYPAD LOCK from the Options Menu.

2. Select the desired lock level.

The following lock levels, listed from lowest to highest restrictions, are available:

<table>
<thead>
<tr>
<th>Lock Level</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Change Lock</td>
<td>R</td>
</tr>
<tr>
<td>Container Lock</td>
<td>C</td>
</tr>
<tr>
<td>Full Lock</td>
<td>F</td>
</tr>
</tbody>
</table>

When the pump is locked under a particular level, a small lock symbol (🔒) appears next to the applied lock level as shown above. When the pump is in RUN or STOP mode, the lock symbol appears in the lower left corner of the display and the lock level abbreviation appears in the lower right corner.

Clinicians: refer to Chapter 5 Clinician Instructions on page 73 for detailed instructions.
### 4. Options Menu

**GemStar® Keypad Lock Level Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>U</th>
<th>R</th>
<th>C</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock/Unlock Keypad</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Power Pump On or Off</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Start or Stop Infusion</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Access Display, Help, Print, and Program Review Functions</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Deliver a Bolus</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Silence an Alarm</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Select a New Container</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Purge</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Change a Program</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Review/Recall Speed Protocol</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Assign or Delete Speed Protocol</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Set Air Sensitivity, Distal Occlusion Level, Sound Level, and Clock</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Clear Shift Totals</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Program and Deliver a Loading Dose (Outside of Programming Mode)</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Enter a New Program</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Operation Test</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Clear History</td>
<td>•</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

* U = Unlock  
  R = Rate Change Lock  
  C = Container Lock  
  F = Full Lock  
* = Function is Available

- Under Rate Change Lock, only the delivery rate or bolus dose volume can be changed and must be within the preset values.
- If programmed.
4. Options Menu

**Change Pump Settings**

1. Press [OPTIONS] and select **PUMP SETTINGS**.
2. Press the number key for the desired pump setting.
3. Follow the display messages. Refer to the instructions of the desired pump setting for more information.

<table>
<thead>
<tr>
<th>Select this item from the Pump Settings Menu:</th>
<th>To do this function:</th>
<th>Comments:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIR SENSOR</td>
<td>Change the air sensor sensitivity.</td>
<td>The pump alarms when it detects an air bubble of approximately 0.5 mL when ON; or at approximately 2 mL when 2 mL is selected. The air alarm does <strong>not</strong> sound if OFF is selected. The air alarm can also be set during programming if the current therapy allows it.</td>
</tr>
<tr>
<td>OCCL SENSOR</td>
<td>Change the distal occlusion sensor sensitivity.</td>
<td>Default Setting: High The pump alarms when distal pressure is greater than the selected occlusion sensor limit.</td>
</tr>
<tr>
<td>SOUND LEVEL</td>
<td>Adjust the audible alarm level.</td>
<td>Default Setting: Maximum</td>
</tr>
</tbody>
</table>

*Note: The current setting flashes on the display.*
4. Options Menu

**Air Sensitivity**

**WARNING: To reduce the risk of infusing air, use an air-eliminating filter when the air sensitivity is set to OFF.**

1. Press [OPTIONS] and select AIR SENSITIVITY. The current air sensitivity flashes on the display.

2. Select the desired Air Sensitivity level.

   *Note: If OFF is selected, the pump displays:

   AIR ELIMINATING
   FILTER IS RECOMMENDED.
   ENTER TO CONFIRM

   You must press [YES/ENTER] to confirm.

3. After selecting the desired Air Sensitivity, the pump displays: CHANGE AIR ALARM FROM XXXX TO XXXX:
   - Press [NO] to keep the current air sensitivity. The current air alarm status displays and the pump exits OPTIONS.
   - Press [YES/ENTER] to accept the new setting. The new air alarm status displays and the pump exits OPTIONS.

**Occlusion Sensor**

1. Press [OPTIONS] and select PUMP SETTINGS.

2. Select DISTAL OCCLUSION from the Pump Settings Menu.

3. Select the desired setting.

4. The pump displays MAKE XXXXX DEFAULT?
   - Press [NO] to temporarily change the distal occlusion setting. The new setting will be in effect until a new program is entered or the pump has been off for more than 24 hours.
   - Press [YES/ENTER] to permanently change the distal occlusion setting. The new setting will remain in effect until the setting is changed again through the Options Menu.
4. Options Menu

Sound Level

1. Press [OPTIONS] and select PUMP SETTINGS.

2. Select SOUND LEVEL from the Pump Settings Menu.

3. When the pump displays the Sound Level function, it sounds intermittent beeps at the current sound level. The blocks on the top line of the display indicate the current sound level.
   - Press ▲ to increase the sound level.
   - Press ▼ to decrease the sound level.
   - Press [CHANGE] to restore the sound level to the default setting.


Set Clock

1. Press [OPTIONS] and select SET CLOCK.

2. Select 12-Hour or 24-Hour format (24-Hour format is shown in example).

3. Use the arrow keys to set the weekday and month.

4. Use the number keys to enter the current day, year, and time.

   Note: When entering the time in 12-Hour format, press ▲ or ▼ to toggle between AM and PM.

5. Press [YES/ENTER] to confirm.

Tip: To view the clock from the RUN or STOP mode, press [YES/ENTER], then immediately press and HOLD [1]. The clock displays until [1] is released.
4. Options Menu

Print

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

Note: Ensure the printer is connected to the pump BEFORE selecting a print function. Refer to Connecting to the Seiko Printer on page 67 for more information.

1. Press [OPTIONS] and select PRINT.
2. Press the number key for the desired print function.
3. When printing is complete, the pump exits OPTIONS.

<table>
<thead>
<tr>
<th>Select this item from the Print Menu:</th>
<th>To do this function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT HISTORY</td>
<td>Print the current program, shift and volume totals, and history event log.</td>
</tr>
<tr>
<td>PRINT PROGRAM</td>
<td>Print the current program.</td>
</tr>
<tr>
<td>PRINT PROTOCOL</td>
<td>Print a specified speed protocol or a complete list of all speed protocols.</td>
</tr>
<tr>
<td>PRINT BOLUS Hx</td>
<td>Print the current program, shift and volume totals, and the bolus history (Hx) for the latest 48 hours.</td>
</tr>
<tr>
<td>STOP PRINT</td>
<td>Cancel printing. This function is only available if the pump is printing.</td>
</tr>
</tbody>
</table>
4. Options Menu

**Speed Protocol**

1. Press [OPTIONS] and select **SPEED PROTOCOL**.
2. Press the number key for the desired protocol function.
3. Follow the display messages. Refer to the instructions for Speed Protocol functions for more information.

<table>
<thead>
<tr>
<th>Select this item from the Speed Protocol Menu:</th>
<th>To do this function:</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSIGN</td>
<td>Store a program in pump memory for later use.</td>
</tr>
<tr>
<td>REVIEW/RECALL</td>
<td>Review assigned protocols from the RUN or STOP mode. Recall an assigned protocol from the STOP mode.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Delete protocols from pump memory.</td>
</tr>
</tbody>
</table>

**Assign**

1. Press [OPTIONS] and select **SPEED PROTOCOL**.
2. Select **ASSIGN** from the Speed Protocol menu.
3. Select [1]–[9] to assign to the new protocol.
   - If the selected speed protocol is already assigned, the pump displays **REPLACE PROTOCOL ASSIGNMENT?**
     - Press [YES/ENTER] to replace the protocol. The pump displays the new speed protocol and exits **OPTIONS**.
     - Press [NO] to keep the existing protocol and exit **OPTIONS**.
4. Options Menu

**Review/Recall**

1. Press **OPTIONS** and select **SPEED PROTOCOL**.
2. Select **REVIEW/RECALL** from the Speed Protocol menu.
3. Select the desired protocol to review/recall.
4. Review the program. Press **YES/ENTER** to begin review.
5. Press **YES/ENTER**:
   - If in the **STOP** mode, press [1] to recall the protocol; or press [2] to review another protocol.
   - If in the **RUN** mode, the pump exits **OPTIONS**.

**Delete**

1. Press **OPTIONS** and select **SPEED PROTOCOL**.
2. Select **DELETE** from the Speed Protocol Menu.
3. Select the desired protocol to delete.
4. Press **YES/ENTER** to confirm deletion or **NO** to exit **OPTIONS** without deleting.
4. Options Menu

Connecting to the Data Port

Use the data port to connect the GemStar Pump to a Seiko® DPU 414 or compatible serial printer to print the Operation Test results or the files available from the Print Menu. Using communication software included with most computer operating systems (or available from local sources), these files can also be transferred to a computer.

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

**Equipment Needed**

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Connect to Printer</th>
<th>Connect to Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Pump</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Hospira Serial Printer Cable List 13078-01</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Seiko DPU 414 or Compatible Serial Printer</td>
<td>•</td>
<td></td>
</tr>
<tr>
<td>Serial DB9 Female-to-Female Gender Changer*</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Null Modem*</td>
<td></td>
<td>•</td>
</tr>
<tr>
<td>Computer*</td>
<td></td>
<td>•</td>
</tr>
</tbody>
</table>

*Available from local sources.
4. Options Menu

Configuration Settings

Refer to the printer or computer documentation for information on configuration settings. Configure the printer or computer as follows to use the data port:

Baud Rate = 2400
Data Bits = 8
Stop Bits = 1
Parity = None
Carriage Return (+Line Feed) = CR+LF
Flow Control = None

Note: When using the Seiko DPU 414 printer, the switch settings MUST be configured to work with the GemStar Pump.

To configure the switch settings on the Seiko DPU 414:

1. Press and hold the ONLINE button while sliding the POWER switch to ON.
2. When the list of the current settings start printing, release the ONLINE button.
3. Set the switches according to the following table.
   Press the ONLINE button to continue setting switches.
   • Press ONLINE to set switch ON.
   • Press FEED to set switch OFF.
4. Continue setting switches until “Dip SW setting complete!!” is printed.
4. Options Menu

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
<th>Setting</th>
<th>Button to Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1-1</td>
<td>Input Method: Serial</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW1-2</td>
<td>Printing Speed: High</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-3</td>
<td>Auto Loading: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-4</td>
<td>CR function: CR and LF</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-5</td>
<td>DIP SW setting command: Enabled</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-6</td>
<td>Printing density: 100%</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW1-7</td>
<td>Printing density: 100%</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW1-8</td>
<td>Printing density: 100%</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-1</td>
<td>Print Mode: 40 columns</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-2</td>
<td>User defined char: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-3</td>
<td>Ordinary Characters: On</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-4</td>
<td>Zero Font: No slash</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-5</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-6</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-7</td>
<td>Character Set: American</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW2-8</td>
<td>Character Set: American</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-1</td>
<td>Data bit length: 8 bits</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-2</td>
<td>Parity: No parity</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-3</td>
<td>Parity condition: Odd</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-4</td>
<td>Flow control: H/S busy</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-5</td>
<td>Baud rate: 2400 bps</td>
<td>On</td>
<td>ONLINE</td>
</tr>
<tr>
<td>SW3-6</td>
<td>Baud rate: 2400 bps</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-7</td>
<td>Baud rate: 2400 bps</td>
<td>Off</td>
<td>FEED</td>
</tr>
<tr>
<td>SW3-8</td>
<td>Baud rate: 2400 bps</td>
<td>On</td>
<td>ONLINE</td>
</tr>
</tbody>
</table>
4. Options Menu

Connecting to the Seiko Printer

WARNING: Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

CAUTION: Do not connect the GemStar AC Mains Adaptor to a printer.

Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer.

1. Install a cassette into the pump.
2. Connect the GemStar serial cable to the printer and to the data port on the bottom of the pump.
3. Ensure the printer is ONLINE and ready to receive data. Refer to printer documentation for more information.
4. Ensure paper is loaded in the printer.
5. Select the desired print function from the pump menu.
4. Options Menu

Connecting to a Computer

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a computer or printer.

*Note: For maximum battery life, operate the pump on AC mains when connected to a printer or computer.*

1. Install a cassette into the pump.
2. Connect the GemStar serial cable to the null modem.
3. Connect the null modem to the serial gender changer.
4. Connect the serial gender changer to the serial port of the computer.
5. Connect the GemStar serial cable to the data port on the bottom of the pump.
6. Configure the communication software on the computer. Refer to *Configuration Settings* on page 65.

*Tip: After the data transfer is complete, use any text editor to view or print the file.*
4. Options Menu

Transferring Data Using a Computer

The GemStar Pump can be connected to a Windows®-compatible computer. The following instructions apply to computers using Microsoft® Windows® 95, Windows® 98, or Windows NT® 4.0 or higher.
4. Options Menu

Creating a New Connection

Note: The following procedure is only needed to create a “New Connection” the first time the pump is connected to the computer.

To create a new connection:
1 Follow steps 1–4 in Using an Existing Connection on the following page.
2 If a message appears asking if a modem is necessary for a connection, click NO.
3 Enter a name for the new connection (e.g., GemStar Print Files) and choose an icon.
4 Click OK.
5 From the Connect drop-down menu, select the appropriate COM port.
6 Click OK.
7 Verify that the following settings are correct:
   Baud Rate = 2400
   Data Bits = 8
   Stop Bits = 1
   Parity = None
   Flow Control = None
8 Click OK.
9 Select the Properties icon.
10 Select the Settings tab.
11 Select the ASCII setup button.
12 Ensure ‘Append line feeds to incoming line ends’ is checked.
13 Click OK in the ASCII setup window.
14 Click OK in the Properties window.
15 From the menu, select File > Save.
16 Exit HyperTerminal.
**Using an Existing Connection**

To transfer data from the GemStar Pump to a computer:

1. From the Windows® desktop, select the Start Menu.
2. Select Programs.
3. Select Accessories.
4. Select HyperTerminal.
5. Double click on the icon with the name entered in step 3, To create a new connection, on page 70.
6. From the menu, select Call > Connect.
7. From the menu, select Transfer > Capture Text.
8. Type the path and file name where the printout should be saved. Ensure the file extension is “.txt”.
   
   The default path is: c:\windows\accessories\hyperterminal.

   *Note: If the file name already exists, the new printout will be added to the end of the existing file. For example, use a patient’s name or id number as the file name. Then select that file for all of that patient’s printouts.*
9. Click Start.
10. Select the desired print function from the pump. Refer to the table of printing functions on page 61.
11. Wait for the transmission to complete.
12. From the menu, select Transfer > Capture Text > Stop.
13. Exit HyperTerminal.
14. Use any text editor to view or print the file.
Chapter 5

Clinician Instructions

The instructions in this section apply to special features available to clinicians. **Remove this section from the manual to prevent unauthorized access to these features.**

The GemStar pump provides quick access to commonly used functions. Instead of accessing these functions by navigating through the menu system, you can enter the key combinations shown in this table:

<table>
<thead>
<tr>
<th>Function</th>
<th>Quick Access Key Combination</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlock Keypad</td>
<td>Place the pump in STOP mode and then enter the lock sequence to unlock a Full Container or Rate Lock.</td>
</tr>
<tr>
<td>Displays Shift Totals</td>
<td>Place the pump in STOP mode and then press [HELP] to display Shift Totals.</td>
</tr>
<tr>
<td>Display Clock</td>
<td>Place the pump in STOP mode, press [YES], and then press and hold [1]. The clock displays until you release [1].</td>
</tr>
<tr>
<td>Program a Loading Dose</td>
<td>From the Pain Management STOP MODE, press [YES/ENTER], and then press [0] to program a Loading Dose.</td>
</tr>
</tbody>
</table>
5. Clinician Instructions

Clinician Locking Sequence Instructions

**Locking the Pump**

**To lock the pump from the RUN or STOP mode:**

1. Press [OPTIONS] to display the Options Menu.
2. Select **KEYPAD LOCK** from the Options Menu.
3. Select the desired lock level. For CONTAINER and FULL Lock, go to step 5.
4. For RATE CHANGE Lock, set the minimum and maximum programmable ranges for the continuous delivery rate and bolus dose in a Pain Management program.

   - **Tip:** Press ( курсор вниз ) to toggle between the MIN and MAX values.
   - **MIN** flashes on the display. Enter the minimum value.
   - **MAX** flashes on the display. Enter the maximum value.
6. Repeat steps 4 and 5 for a bolus dose if available in the current program.
7. Enter the lock sequence number [1][3][0][0][0]. Asterisks display as the numbers are entered.

   **Note:** Default lock sequence numbers are shown.
5. Clinician Instructions

Unlocking the Pump

1. Press [OPTIONS] to display the Options Menu.
2. Select KEYPAD LOCK from the Options Menu.
3. Select the lock level to be unlocked.
4. Enter the lock sequence number for that level.
5. The pump displays the current lock level. Press [YES/ENTER] to return to the mode the pump was in when [OPTIONS] was pressed.

Program and Deliver a Clinician Activated Loading Dose

This feature is available only when the keypad is UNLOCKED. The default loading dose rate is 125 mL/hr.

1. From the stop mode, press [YES/ENTER] [0].
3. Enter the loading dose. Press [YES/ENTER].
4. The pump displays: DELIVER THE LOADING DOSE NOW?
   To deliver the loading dose immediately, press [YES/ENTER].
   Primary infusion DOES NOT begin automatically when the clinician activated loading dose is complete. Press [START] to continue primary infusion.

   To deliver the loading dose later, press [NO].
   The pump returns to the stop mode. The next time [START] is pressed, the pump again displays: DELIVER LOADING DOSE NOW?
   • Press [YES/ENTER] to deliver the loading dose. Primary infusion continues automatically when the loading dose is complete.
   • Press [NO] to cancel the loading dose and continue primary infusion.
5. Clinician Instructions

Shift Totals and History

Shift Totals

1. Press [OPTIONS] and select HISTORIES.
2. Select SHIFT TOTALS from the Histories Menu.
3. The shift totals display. Press ▲ and ▼ to scroll the display. When done, the pump displays CLEAR TOTALS? YES OR NO.
   • Press [YES/ENTER] to clear the shift totals.
   • Press [NO] to exit OPTIONS without clearing the shift totals.

Tip: Press [HELP] to display shift totals when the pump is not in PROGRAMMING mode or an alarm condition.

Clear History Event Log and Bolus History

1. Press [OPTIONS] and select HISTORIES.
2. Select CLEAR HISTORY.
3. CLEARING HISTORY displays and the pump exits OPTIONS.
Chapter 6

Troubleshooting

This section contains information on audible and visual alarms that may occur with the GemStar Pump.

CAUTION: If the pump does not perform as stated in this manual, stop using it IMMEDIATELY.

For consultation and technical support contact either an authorized Hospira representative or the Hospira Technical Support Operations hotline (available 24 hours a day).

To return the pump for service, first contact Hospira Customer Support between 7:00 AM and 4:00 PM Pacific time. Have the pump serial number available.

In the USA

Hospira Technical Support Operations
1-800-241-4002

Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Outside the USA:

Contact your local Hospira sales office.

Tip: Press [HELP] for additional information during programming and alarm conditions.
6. Troubleshooting

## Alarm Messages

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Condition</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| AIR IN LINE           | N                    | A/V             | 1. Press [SILENCE] to quiet the alarm for 1 minute.  
|                       |                      |                 | 2. Press [STOP] to clear the alarm.  
|                       |                      |                 | 3. Disconnect the patient from the pump set.  
|                       |                      |                 | 4. Press and hold [PURGE].  
|                       |                      |                 | Note: Purge rate is 250 mL/hr. The pump purges for up to 2 minutes each time you press and hold [PURGE]. Purge volume may be limited in a Pain Management program.  
|                       |                      |                 | 5. Reconnect the pump set to the patient-access device.  
|                       |                      |                 |        |
| CHANGE BATTERIES      | N                    | A/V             | 1. Replace both disposable batteries with fresh AA batteries and press [RESTART] to restart the pump; OR connect the pump to the AC mains adaptor and the pump will automatically restart. Replace both batteries as soon as possible.  
|                       |                      |                 | 2. After power-on, resume the current program. Refer to Accessing the Delivery Mode Menu in Chapter 2 Basic Operation for more information.  |

Y = Yes  
N = No  
A = Audible alarm  
V = Visual alarm
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHECK CASSETTE-X</td>
<td>N</td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>V = Visual alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A</td>
<td>The cassette is improperly installed or not installed.</td>
<td>1 Press [SILENCE] to quiet the alarm for 1 minute.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>X indicates where to look for the cause of the alarm:</td>
<td>2 Press [STOP] to place the pump in the STOP mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A = Air Sensor</td>
<td>3 Reinstall the cassette.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>D = Distal</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>P = Proximal</td>
<td></td>
</tr>
<tr>
<td>CALL 1.800.XXX.XXXX</td>
<td>N</td>
<td>A/V</td>
<td></td>
</tr>
<tr>
<td>CODE: NN/MMM/TTT</td>
<td></td>
<td>The pump has detected a condition that may require service.</td>
<td>1 Write down the telephone number and code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2 Power-off the pump. If the pump does not power-off, disconnect external power and remove the batteries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3 Call the telephone number shown on the display message.</td>
</tr>
</tbody>
</table>

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed.

Note: Ensure the tubing is behind the tubing guide (at the distal end). Refer to Loading the Cassette on page 30.

Note: The pump cannot be powered off during a CHECK CASSETTE alarm (except during PROGRAMMING mode).
### 6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| DIST. OCCLUSION N A/V   |                      |                      | 1. Press [SILENCE] to quiet the alarm for 1 minute.  
                          |                      |                      | 2. Press [STOP] to place the pump in the stop mode.  
                          |                      |                      | 3. Check for sources of distal occlusion:  
                          |                      |                      | ▶ Kinked tubing below the pump  
                          |                      |                      | ▶ Clamped patient-access device  
                          |                      |                      | ▶ Clogged I.V. filter  
                          |                      |                      | ▶ Other obstructions  
                          |                      |                      | 4. If the problem continues, remove and reinstall the cassette.  
                          |                      |                      | **CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed.  
                          |                      |                      | **Note:** Ensure the tubing is behind the tubing guide (at the distal end). Refer to **Loading the Cassette** on page 30.  
                          |                      |                      | 5. Press [START] to begin infusion. |
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOW BATTERIES</td>
<td>Y</td>
<td>A/V</td>
<td>1. Press [SILENCE] to quiet the alarm for 15 minutes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Press [STOP] to place the pump in the STOP mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Connect the pump to AC mains adaptor, rechargeable battery pack, OR replace both disposable batteries with fresh AA batteries.</td>
</tr>
</tbody>
</table>

*If an external power source is used, the rate is changed, or the pump is powered-on after a LOW BATTERIES alarm and those same batteries are still in the pump, this interval may be different.*
## 6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td></td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td>V = Visual alarm</td>
<td></td>
</tr>
<tr>
<td><strong>POWER LOSS</strong></td>
<td>N</td>
<td>A/V</td>
<td>1</td>
</tr>
</tbody>
</table>
|                       |                       | The pump has detected a power failure due to one of the following:  
|                       |                       | • Batteries have been removed while the pump was on battery source.  
|                       |                       | • External power has failed or has been disconnected and no batteries are installed.  
|                       |                       | • Pump has been powered on with insufficient power source.  
|                       |                       | 2                   |
|                       |                       | Power-on the pump. Review the program if required.  
|                       |                       | 3                   |
|                       |                       | Press [START] to begin infusion.  |
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>PROX. OCCLUSION</td>
<td>N</td>
<td>A/V</td>
<td></td>
</tr>
</tbody>
</table>

The pump has detected sustained negative pressure on its proximal side.

1. Press [SILENCE] to quiet the alarm for 1 minute.
2. Press [STOP] to place the pump in the stop mode.
3. WARNING: When a Proximal Occlusion alarm activates, DO NOT power-off the pump.
4. Check for sources of proximal occlusion:
   - Kinked tubing above pump
   - Blockage in the container and in the spike
   - Closed clamps above pump
   - Empty container
   - High torque syringe
   - Other obstructions
5. Remove obstructions.
7. If the problem continues, power-off the pump. Install a new primed set and begin infusion.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed.

Note: Ensure the tubing is behind the tubing guides (at the distal end). Refer to Loading the Cassette on page 30.
6. Troubleshooting

<table>
<thead>
<tr>
<th>Alarm Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USING BATTERIES</strong></td>
<td>Y</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>A Audible alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>V Visual alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is a normal response when:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has been powered on with only disposable batteries as a power source; or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has switched to internal power (disposable batteries) due to a loss of external power or a reduction in external power below acceptable levels.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>When powering on the pump:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Press [YES/ENTER] to confirm disposable batteries are the only power source.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>When switching from AC mains power:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Press [SILENCE] to clear the alarm.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>USING EXT BATT</strong></td>
<td>Y</td>
<td>V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y</td>
<td>A Audible alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>V Visual alarm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is a normal response when:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has been powered on with external batteries as a power source; or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has switched to external battery power due to a loss of AC mains power; or</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The pump has switched to external battery power while running on internal batteries.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>When powering on the pump:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Press [YES/ENTER] to confirm external battery power source.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>When switching from AC mains power:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Press [SILENCE] to clear the alarm.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## 6. Troubleshooting

### Alert Messages

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alar m</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALMOST EMPTY</td>
<td>Y</td>
<td>A/V</td>
<td>Delivery will complete in 30 minutes or less. For bolus only program, delivery will complete during the next bolus delivery.</td>
<td>• Press [SILENCE] to quiet the alarm for 10 minutes. Note: This alert is available only with Pain Management protocols.</td>
</tr>
<tr>
<td>CHECK PRINTER</td>
<td>Y</td>
<td>A/V</td>
<td>• The printer has not responded to commands from the pump. • The printer is not properly connected to the pump.</td>
<td>1 Press [SILENCE] to quiet the alarm for 2 minutes. 2 Ensure the printer is properly connected to the pump by checking the following:  - Printer is powered on and in ONLINE mode.  - Cable is plugged in to both the pump and the printer.  - Cable part number and printer settings are correct. 3 If the problem continues, select STOP PRINT from the Print Menu to cancel all print jobs.</td>
</tr>
</tbody>
</table>

Y = Yes  
N = No  
A = Audible alarm  
V = Visual alarm
### 6. Troubleshooting

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
</table>
| EMPTY CONTAINER                        | N                     | A/V   | The pump has delivered the programmed container size or the pump has delivered the programmed VTBI; AND Auto KVO is delivering (if available in current program). | 1. Press [SILENCE] to quiet the alarm for 2 minutes.  
2. Press [STOP] to place the pump in the STOP mode and clear the alarm.  
3. Use the NEW CONTAINER function to repeat the current program. Refer to Starting a New Container in Chapter 2 Basic Operation. |
| FLASHING DISPLAY                        | N                     | A/V   | A Non-programming Callback has occurred because the pump has been waiting for more than three minutes for a keypress on a non-programming input or a confirmation display. | Follow the instructions on the display to clear the alarm. |
| NO INTERNAL BATT NO POWER LOSS ALARM AVAILABLE ENTER TO CONFIRM | N                     | A/V   | No disposable batteries or dead disposable batteries; AND external power.        | 1. Press [YES/ENTER] to confirm.  
2. Power-off the pump and install two fresh, disposable AA batteries as a backup power source. |
| PROGRAMMING INCOMPLETE                 | N                     | A/V   | Programming has not been completed and no keys have been pressed within three minutes. | 1. Press any key to clear the alarm.  
2. Complete the program entries. |
### 6. Troubleshooting

<table>
<thead>
<tr>
<th>Alert Display Message</th>
<th>Is the pump infusing?</th>
<th>Alarm</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y = Yes</td>
<td></td>
<td></td>
<td>A = Audible alarm</td>
<td></td>
</tr>
<tr>
<td>N = No</td>
<td></td>
<td></td>
<td>V = Visual alarm</td>
<td></td>
</tr>
</tbody>
</table>

**START**
- START flashes on the display. Other parts of the display are not affected.

<table>
<thead>
<tr>
<th></th>
<th>Y</th>
<th>A/V</th>
<th>A Stop Mode Callback has occurred because the programmed pump has remained in the STOP mode for more than three minutes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>START</td>
<td>N</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Press [SILENCE] to quiet the alarm for 3 minutes.
2. Follow the instructions on the display to clear the alarm.
6. Troubleshooting

Other Display Messages

<table>
<thead>
<tr>
<th>Other Display Message</th>
<th>Cause/Condition</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEYPAD LOCKED</td>
<td>User has attempted to perform a function that has been locked out.</td>
<td>Unlock the keypad to access the desired function.</td>
</tr>
<tr>
<td>NOT ALLOWED DURING INFUSION PRESS STOP TO HALT DELIVERY</td>
<td>User has attempted to perform a function that is not available in RUN mode.</td>
<td>• Press [STOP] to access the desired function.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Press [YES/ENTER] to return to the RUN mode display.</td>
</tr>
<tr>
<td>ROUNCING</td>
<td>The pump has rounded a number that was entered during programming.</td>
<td>Press [YES/ENTER] to accept the rounded value and continue to the next step.</td>
</tr>
<tr>
<td>• The pump sounds four quick beeps and displays the rounded number.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOSE IN PROGRESS NEW CONTAINER NOT ALLOWED</td>
<td>User has attempted to access NEW CONTAINER function when it is not allowed.</td>
<td>1 Press [STOP].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Increase the container size to complete the dose.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Set NEW CONTAINER through the Change Menu.</td>
</tr>
<tr>
<td>CANNOT CHANGE CLOCK WHILE TIME BASED DELIVERY IS IN PROGRESS</td>
<td>User has attempted to change the clock during a time-based delivery.</td>
<td>1 Press [STOP].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Clear the program through the Change Menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Change the clock through the Options Menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 Reprogram the pump.</td>
</tr>
<tr>
<td>THIS OPTION NOT AVAILABLE WHILE PROGRAMMING THE PUMP</td>
<td>User has attempted to access a function that is not available from the first programming display.</td>
<td>1 Press [YES/ENTER] to return to the first programming display.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Complete programming.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 Access desired function.</td>
</tr>
</tbody>
</table>
Chapter 7

Maintenance

Pump Storage

Store the GemStar Pump in a cool, dry place. Remove the disposable batteries and the battery pack before storing the pump.

Program and event history are protected in the software memory for at least one year when power is removed from the pump.

Cleaning and Disinfecting

Establish a routine schedule for cleaning the pump to keep the case exterior, cassette pocket, and tubing channel free of contamination.

CAUTION: To avoid mechanical or electronic damage, do not immerse pump in any fluids or cleaning solutions.

Some cleaning and sanitizing compounds may slowly degrade components made from some plastic materials. Do not use compounds containing combinations of isopropyl alcohol and dimethyl benzyl ammonium chloride.

Do not sterilize by heat, steam, ETO, or radiation. Apply disinfectants to the outside surface of the pump only. Do not use abrasive cleaners or materials on the pump. Using abrasive cleaners or cleaning solutions not recommended by Hospira may result in product damage.

To avoid pump damage, cleaning solutions should be used only as directed in the table on the following page. The disinfecting properties of cleaning solutions vary; consult the manufacturer for specific information.

Never use sharp objects (such as pens, pencils, fingernails, paper clips, needles, etc.) to clean the pump.
7. Maintenance

**Recommended Cleaning Solutions**

The pump is not adversely affected by the recommended cleaning solutions in the table below:

<table>
<thead>
<tr>
<th>Cleaning Solution</th>
<th>Manufacturer</th>
<th>Preparation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Super Edisonite®</td>
<td>S. M. Edison Chemical Co.</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Vesphene II se®</td>
<td>Calgon Vestal Laboratories</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Manu-Klenz®</td>
<td>Calgon Vestal Laboratories</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Formula C™</td>
<td>Diversey Corp.</td>
<td>Per manufacturer’s recommendation</td>
</tr>
<tr>
<td>Household bleach (5.25% sodium hypochlorite)</td>
<td>Various</td>
<td>Per healthcare facility procedures; DO NOT exceed one part bleach in ten parts water</td>
</tr>
</tbody>
</table>

*Note: NOT all cleaning solutions are disinfectants. Check product labeling.*

**Cleaning the Pump Case**

1. Power-off the pump.
2. Disconnect the pump from AC mains power.
3. Clean the exposed surfaces of the pump with a soft, lint-free cloth dampened with the appropriate cleaning solution.
4. Wipe the solution from the pump surface with a water-moistened, lint-free cloth.
5. Use a dry, lint-free cloth to dry the pump after cleaning.
Cleaning the Cassette Pocket and Tubing Channel

The area containing the ultrasonic sensors, located in the cassette pocket, should be cleaned on a regular basis.

**CAUTION:** Use care not to damage the silicone seals around the sensor bodies.

1. Remove the cassette, if installed.
2. Use a cotton swab, moistened with an approved cleaning solution, to clean the sensor faces (A), tubing channel (B), plunger tip (C), and sensor pins (D).
3. Dry the sensor faces and tubing channel and ensure the sensor faces are free of detergent film and/or debris.

Repair

- The GemStar Pump has no user-serviceable components, with the exception of disposable batteries.
- If the display clock stops working, contact Hospira Technical Support Operations to arrange for internal lithium battery replacement.
- **Homecare Customers:** Call your healthcare professional or homecare company regarding any required service or repairs. DO NOT attempt to repair the pump for any reason.
- The GemStar Pump is covered by a manufacturer’s warranty for one year after purchase. During this time, opening the pump case for any reason voids this warranty. Refer to Chapter 12 Warranty/Technical Assistance, page 137 for details.
- Refer all service to Hospira certified technicians only. A GemStar Technical Field Service Manual is available to Hospira certified technicians.
Chapter 8

Operation Test

This test is designed to ensure the GemStar Pump is operating properly. Hospira recommends performing this test a minimum of once every 12 months. Refer to facility requirements to determine additional testing needs.

The test can be performed when the pump is in the STOP mode and requires approximately 15 minutes to complete. The pump provides step-by-step instructions through each section of the test.

Note: This test is available only when the pump is UNLOCKED.

WARNING: Disconnect the pump from the patient BEFORE performing the Operation Test.

Equipment Required
- GemStar Pump
- Two GemStar Microbore Pump Sets without a filter
- Reservoir with at least 50 mL of water
- 20+ mL or larger graduated cylinder (graduated in 0.1 mL)
- Two fresh, disposable AA batteries
- Appropriate GemStar AC Mains Adaptor or other Hospira approved external power source
8. Operation Test

Test Setup

Note: The pump clears any program and shift totals stored in pump memory before starting the Operation Test.

1. Connect the external power source and install two fresh, disposable AA batteries.
2. Power-on the pump.
3. Press [OPTIONS].
4. Select HISTORIES from the Options Menu.
5. Select OPERATION TEST from the Histories Menu.
6. Follow the instructions on the display.

Performing the Operation Test

Tip: The checklist at the end of this section may be copied to record test results.

Case Inspection

1. Visually inspect the case and keypad for damage. Check the case for missing screws, or labels.
2. Enter the results:
   • If the pump is free of damage and all the screws and labels are in place, press [YES/ENTER].
   • If damage is found on the case or keypad, or any screws or labels are missing, press [NO].
8. Operation Test

**Cassette Pocket and Latch Inspection**

1. Visually inspect the cassette pocket and the sensors (A). Verify that they are free of dirt and residue.

2. Verify that the four cassette latches (B) are present. Verify that they open and close when the cassette release button is pressed.

3. Verify that the plunger seal (C) and sensor seals (D) are present and intact.

4. Verify that the plunger (E) is not scraped or damaged.

5. Verify that the sensor pins (F) are not damaged.

6. Install the cassette. Verify the cassette fits smoothly and securely.

7. Enter the results:
   - If the cassette pocket area and latches are free of damage, and ALL of the above steps are verified, press **[YES/ENTER]**.
   - If damage is found, or ANY of the above steps cannot be verified, press **[NO]**.
8. Operation Test

**Power Check**

Tip: Opening the battery compartment door will disconnect the batteries enough for the pump to recognize external power. Then the door can be tightened and testing can continue. This can save time when performing multiple tests on a group of pumps.

1. The display indicates that an external power source and batteries are connected. Press [▼].
2. Remove battery door and press [▼]. The display indicates that only external power is connected. Press [▼].
3. Return the battery door to the closed position.
4. Disconnect the external power source and press [▼].
5. The display indicates that only batteries are connected and displays the test results. Press [▼].
6. If the pump fails, reconnect the external power source and press [▲] to rerun the test, or press [YES/ENTER] to confirm failure.

**Keypad Test**

2. Enter the results:
   - If each key makes an audible tone, press [YES/ENTER].
   - If any key does not make an audible tone, press [NO].

**Display Test**

1. Press [YES/ENTER] when prompted. The display fills with solid boxes for approximately 10 seconds. To view the solid boxes for another 10 seconds after the display times-out, press [▲].
2. Enter the results:
   - If the display fills with solid boxes, press [YES/ENTER].
   - If the display does not fill with solid boxes, press [NO].
8. Operation Test

**LED Test**

1. Verify that both the Power (green) and Alarm (red) LEDs are lit. Refer to *GemStar Pump Layout* on page 2 for the location of the LEDs.

2. Enter the results:
   - If both LEDs are lit, press [YES/ENTER].
   - If either of the LEDs does not light, press [NO].

Tip: Use two microbore pump sets to save time during the next four tests. The first set should be fully primed BEFORE beginning the volume accuracy test. Use a second, DRY set for the air-in-line test.

When the proximal occlusion test is complete, remove the WET set from the pump and insert the DRY set. Press [START] to begin the air-in-line test. The WET set can then be placed in the next unit ready for testing.

**Volume Accuracy Test**

The pump should deliver between 19.0 to 21.0 mL within approximately 3 minutes to pass this test.

1. Load a primed pump set into the pump. Press (▼).
2. Place the proximal end in the reservoir of water. Press (▼).
3. Place the distal end in a 20+ mL graduated cylinder. Press (▼).
4. Press [START].
5. Enter the results:
   - If the pump delivers between 19.0 to 21.0 mL, press [YES/ENTER].
   - If the pump does not deliver between 19.0 to 21.0 mL, press [NO].
8. Operation Test

**Distal Occlusion Test**

The occlusion should occur within approximately 30 seconds to pass this test.

1. Clamp the pump set **10 to 12 inches** (25.4 to 30.5 cm) below the cassette.
2. Press [START].
3. The test result displays. Release the clamp and press [●].
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press [●] to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the distal occlusion test. Refer to Chapter 7 Maintenance for instructions.*

**Proximal Occlusion Test**

The occlusion should occur within approximately 30 seconds to pass this test.

1. Clamp the pump set above the cassette.
2. Press [START].
3. The test result displays. Press [●].
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press [●] to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor pins before repeating the proximal occlusion test. Refer to Chapter 7 Maintenance for instructions.*
8. Operation Test

**Air-in-line Test**

The air-in-line alarm should occur within approximately 1 minute to pass this test.

1. Release the clamp.
2. Remove the proximal end of the pump set from the reservoir. Press $\downarrow$.
3. Press [START].
4. The test result displays. Press $\downarrow$.
   - If the test is passed, the pump advances to the next test.
   - If the test is failed, clean the sensors and press $\uparrow$ to rerun the test or press [YES/ENTER] to confirm failure.

*Note: Clean the sensor faces before repeating the air-in-line-test. Refer to Chapter 7 Maintenance for instructions.*

**Printing Test Results**

When the test is complete, the pump displays an option to print the test results. If desired, follow the steps below to print the test results. An example of the printed test results is shown.

*Note: For maximum battery life, operate the pump on AC mains power when connected to a printer or computer.*

1. Connect the serial printer cable to the pump. Refer to Connecting to the Seiko Printer in Chapter 4 Options Menu, on page 67.
2. Press [YES/ENTER] to print the test results.
3. The pump displays the Delivery Mode Menu when the results have finished transmitting or if [NO] is pressed.
8. Operation Test

*******************************************************************************
*     HOSPIRA GemStar       *
*     OPERATION TEST        *
*     RESULTS              *
*******************************************************************************

PUMP SERIAL NUMBER: XXXXXXXXXX

10:45AM JUL 4, 04
VERSION X.X.X

1. Case Inspection        PASS
2. Cassette Pocket & Latch PASS
3. Power Check            PASS
4. Keypad Test            PASS
5. Display Test           FAIL
6. LED Test               PASS
7. Volume Accuracy Test   PASS
8. Distal Occlusion Test  PASS
9. Proximal Occlusion Test PASS
10. Air-in-Line Test      PASS

*******************************************************************************
*     VERIFIED BY:          *
*******************************************************************************

*******************************************************************************
*     END OF                *
*     OPERATION TEST        *
*     RESULTS               *
*******************************************************************************
1234567890123456789012345678901234567890
8. Operation Test

**GemStar®**

**Operation Test Checklist**

<table>
<thead>
<tr>
<th>Test</th>
<th>Pass</th>
<th>Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Cassette Pocket and Latch Inspection</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Power Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Keypad Check</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Display Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>LED Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Volume Accuracy Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Distal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Proximal Occlusion Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Air-in-line Test</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Printed Test Results</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

Serial Number: ____________

Verified By: ____________ Date: ____________
## Optional System Components

All GemStar Optional System Components are composed of latex-free components only.

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar AC Mains Adaptor (110 Volts - USA)</td>
<td>13026-01</td>
<td>Wall-mount adaptor plugs into a 110 VAC mains supply to power the GemStar Pump. 6 ft (1.8 m) cord.</td>
</tr>
<tr>
<td>GemStar AC Mains Adaptor (100 – 240 Volts - Universal)</td>
<td>13072-01</td>
<td>Tabletop adaptor plugs into a 100 – 240 VAC mains supply to power the GemStar Pump.</td>
</tr>
<tr>
<td>GemStar Bolus Cord</td>
<td>13027-01</td>
<td>Allows bolus requests to be made up to 6 feet (1.8 m) from the pump.</td>
</tr>
<tr>
<td>GemStar Pole Clamp</td>
<td>13076-01</td>
<td>Attaches the GemStar Pump to an I.V. pole. The clamp is mounted to the track on the back of the pump. Press the release button to remove the pump.</td>
</tr>
<tr>
<td>GemStar Battery Pack</td>
<td>13073-01</td>
<td>The rechargeable nickel metal hydride batteries power the GemStar Pump during periods of transport or when use of AC power is not desirable. The battery pack is recharged using a GemStar AC Mains Adaptor.</td>
</tr>
<tr>
<td>GemStar Universal Lockbox</td>
<td>12499-01</td>
<td>Locks the GemStar Pump and up to a 250 mL flexible I.V. container or 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately).</td>
</tr>
<tr>
<td>GemStar 250 mL Lockbox</td>
<td>13024-01</td>
<td>Locks the GemStar Pump and up to a 250 mL flexible I.V. container in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately).</td>
</tr>
</tbody>
</table>
### 9. Optional System Components

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar 30 mL PCA Vial Lockbox</td>
<td>13077-01</td>
<td>Locks the GemStar Pump and a 30 mL PCA vial in a plastic enclosure. The lockbox can be attached to an I.V. pole using the GemStar Pole Clamp (available separately).</td>
</tr>
<tr>
<td>Hospira Carrying Case - 250 mL</td>
<td>13594-01</td>
<td>Soft-sided carrying case can be worn around the waist to hold the GemStar Pump and up to a 250 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 500 mL</td>
<td>13079-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar Pump and up to a 500 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 1000 mL</td>
<td>13980-01</td>
<td>Soft-sided carrying case can be worn around the waist or over the shoulder to hold the GemStar Pump and up to a 1000 mL flexible container.</td>
</tr>
<tr>
<td>Hospira Carrying Case - 3 Liter</td>
<td>13593-01</td>
<td>Soft-sided carrying case can be worn around the waist or as a backpack to hold a 3 liter or smaller flexible container and the GemStar Pump with batteries or battery pack. Includes List 13590-01.</td>
</tr>
<tr>
<td>Hospira 3 Liter Carrier</td>
<td>13590-01</td>
<td>Interior support for the Hospira Carrying Case - 3 Liter.</td>
</tr>
<tr>
<td>GemStar Docking Station (100 – 240 Volts)</td>
<td>13075-01</td>
<td>Plugs into a 100 – 240 VAC Volt mains supply to power the GemStar Pump while mounted on an I.V. pole. During periods of transport, an internal rechargeable battery pack powers the pump for up to 16 hours at a rate of 125 mL/hr or less. When the AC mains supply is attached, the internal batteries are recharged in 4 to 6 hours. 12 ft. (3.6 m) cord.</td>
</tr>
<tr>
<td>GemStar Serial Cable</td>
<td>13078-01</td>
<td>Connects the GemStar Pump to a compatible serial printer or computer to download the event history, program, or speed protocol information.</td>
</tr>
</tbody>
</table>
## 9. Optional System Components

<table>
<thead>
<tr>
<th>Product Description</th>
<th>List #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GemStar Connect Clinician Kit</td>
<td>13048-01</td>
<td>Allows remote access from a clinician’s computer to a GemStar Pump. The Kit includes a modem, phone cable, serial cable, and GemStar Connect software.</td>
</tr>
<tr>
<td>GemStar Connect Patient Kit</td>
<td>13049-01</td>
<td>Use with the GemStar Connect Clinician Kit to allow remote access to a GemStar Pump. The Patient Kit includes a modem, phone cable, and remote pump cable.</td>
</tr>
<tr>
<td>GemStar Triple Pole Clamp</td>
<td>13022-01</td>
<td>Not for use with a lockbox.</td>
</tr>
<tr>
<td>GemStar Configuration Guide</td>
<td>13000-97</td>
<td>Provides advance instructions for biomed technicians.</td>
</tr>
<tr>
<td>GemStar System Operating Manual</td>
<td>13981-01</td>
<td>Provides operating instructions for patients and caregivers.</td>
</tr>
</tbody>
</table>
9. Optional System Components

**Connecting the Bolus Cord**

(List 13027-01)

Connect the bolus cord to the port labeled “Bolus” on the bottom of the pump.

**CAUTION:** When removing the cord from the bottom of the pump, firmly grasp the connector and pull straight out. DO NOT twist or bend the cord or connector.

**Using the GemStar Lockboxes**

The GemStar Lockbox is an enclosure that can be locked with a key to secure the pump, and a flexible container or vial. When the pump is secured in the lockbox, the user has access to the AC mains connector, data and bolus ports, keypad, and bolus button.

*Note: For the GemStar Universal Lockbox (List 12499-01) refer to the lockbox for instructions.*
9. Optional System Components

**30 mL PCA Vial Lockbox (List 13077-01)**

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Flip the top door down.
6. Connect the pump set to the vial and prime.
7. Place the vial inside the lockbox (D).
8. Load the cassette (E).

**CAUTION:** Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to *Loading the Cassette* on page 30.

9. Ensure the tubing will not be pinched when closing the lockbox.
10. Close and lock the lockbox.
11. Remove the key.
9. Optional System Components

250 mL Lockbox (List 13024-01)

1. Open the lockbox (A).
2. Flip the top door up (B).
3. Align the pump with the lockbox (C).
4. Slide the pump down into the lockbox until fully seated.
5. Flip the top door down.
6. Connect the pump set to the bag and prime.
7. Place the flexible container inside the lockbox with the administrative port down (D).
8. Hang the bag on the hook inside the lockbox (E).
9. Load the cassette (F).

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 30.

Note: Ensure the tubing is in the tubing guide (at the distal end).

10. Ensure the tubing will not be pinched when closing the lockbox.
11. Close and lock the lockbox.
12. Remove the key.
9. Optional System Components

Removing the Lockbox

1. Remove the lockbox from the pole.
2. Unlock the lockbox.
3. Open the lockbox and flip the top door up.
4. Press the cassette release button to remove the cassette.
5. Lift the pump out of the lockbox.

Using the Hospira Carrying Cases

Ensure the administration set is fully primed and the cassette is properly loaded before placing the pump in the carrying case. Refer to Chapter 2 Basic Operation for more information.

Carrying Case - 250 mL (List 13594-01)

This soft-sided carrying case can be worn around the waist. It is designed to hold the GemStar Pump and up to a 250 mL flexible fluid bag.

1. Place the fluid bag in the zippered compartment (A) on the backside of the case. Ensure the bag spike is positioned so that the fluid flow is not restricted.

2. Place the pump inside the front compartment (B) of the case.
9. Optional System Components

3 Secure the tubing to the inside of the pack with the Velcro® tabs (C). Ensure the tubing is not kinked.

4 Use the large Velcro flap (D) on the upper left side of the case to secure the tubing on the outside of the case.

5 Close the zipper. Ensure the tubing exits the side of the case near the zipper tab when the zipper is closed (E).

6 Place the case around the waist. Snap the buckle together to secure.

7 Adjust the belt for a snug, comfortable fit.

Carrying Case - 500 mL (List 13079-01) or 1000 mL (List 13980-01)
These soft-sided carrying cases can be worn around the waist or over the shoulder. They are designed to hold the GemStar Pump and up to a 500 mL (List 13079-01) or a 1000 mL (List 13980-01) flexible fluid bag.
9. Optional System Components

1. Place the pump on the inside front window (A). Ensure the keypad is facing the “window.”

2. Secure the pump with the large side straps (B) and (C). Then secure the top (D) and bottom (E) straps.

3. Place the fluid bag on the backside of the compartment (F).

4. Secure the bag with flaps (G) and (H).

5. Secure the bag spike with strap (I). Ensure the fluid flow is not restricted.

6. Use a “figure-8” pattern to wrap the tubing. Secure the tubing to the inside of the case with tabs (J) and (K). Ensure the tubing is not kinked.

7. Zip the case closed. Ensure the tubing exits through one of the sides near the zipper tab when the case is closed.
9. Optional System Components

8 Place the case around the waist with the front “window” facing away from the body. Snap the buckle together to secure. Adjust the belt for a snug, comfortable fit.

Carrying Case - 3 Liter (List 13593-01)

This soft-sided carrying case can be worn around the waist or as a backpack. It is designed to hold the GemStar Pump with batteries or a battery pack, and up to a 3 liter flexible fluid bag.

Note: This carrying case includes an interior support (Hospira 3 Liter Carrier List 13590-01) that may be removed from the case and used separately.
9. Optional System Components

1. Unzip the carrying case and release all Velcro straps and flaps.
2. Place the fluid bag on the carrying case as shown (A).
3. Hook top strap (B) through the hole in the top of the fluid bag and secure.
4. Fold small flaps (C) and (D) over the bag as shown and secure.
5. Secure straps (E) and (F) across the length of the fluid bag and over the small flaps.
6. Secure the spike connection with strap (G).
7. Fold large flaps (H) and (I) over as shown and secure.
8. Place the pump, with the keypad facing upward, inside the pocket (J) on the flap. The pump’s display should be visible through the opening on the front of the pocket.
9. Secure the pump with straps (K) and (L).
10. Secure the tubing with strap (M).
11. Place the secured pump (N) inside the large zipper case or other carrying case.
12. Zip the large case closed.
13. If desired, route the tubing through the loops on the bottom of the carrying case. Ensure the tubing is not kinked.
14. Adjust the shoulder straps and waist belt for a snug, comfortable fit.

Tip: When not using the waist belt, secure it under the large flap on the back of the case.
9. Optional System Components
9. Optional System Components

Using the GemStar Docking Station
(List 13075-01)

Connecting the Pump

1. Mount the docking station to the I.V. pole and tighten the knob.
2. Align the connectors on the bottom of the pump with the connectors on the docking station.
3. Slide the pump into the docking station until it snaps into place.
4. Connect the docking station to AC mains power.

*Note: The docking station light is yellow while the docking station is charging. When the docking station is fully charged, the light is green.*
9. Optional System Components

Connecting the Bolus Cord and Printer Cable

**WARNING:** Ensure a cassette is installed in the pump before connecting to a printer or computer.

If the pump is connected to a patient: BEFORE connecting the pump to a computer or printer, press [STOP], close the slide clamp, and eject the cassette. Leave the pump set connected to the patient. Install another cassette in the pump before connecting to a printer or computer.

1. Plug the bolus cord into the bolus port on the rear, right side of the docking station.

2. Plug the printer cable into the printer port on the rear, right side of the docking station.

Disconnecting the Pump

To remove the pump:

1. Press the release button on the top of the docking station.

2. Slide the pump out.
Chapter 10

Pump Sets

CAUTION: USE ONLY GemStar Pump Sets with the GemStar Pump. Use of unauthorized sets may result in injury to the patient or damage to the pump.

Contact a Hospira Representative for appropriate pump set configurations.

Fluid path and areas beneath undisturbed protective set covers are sterile and nonpyrogenic in the intact unit package.

The GemStar Pump Sets, listed in the table on the following page are available for use with the GemStar Pump.

Note: The disposable pump sets should be changed per the Centers for Disease Control (CDC) guidelines or health care provider policy. Discard after use. All GemStar Pump Sets are composed of latex-free components only.

GemStar Pump Sets contain an anti-siphon valve to reduce the potential for gravity flow at a typical 36-inch head height.
10. Pump Sets

The following sets are a representation of the GemStar® Pump Sets currently available:

<table>
<thead>
<tr>
<th>List No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Ambulatory Sets</strong></td>
</tr>
<tr>
<td>13273</td>
<td>Latex-Free GemStar® Pump Set, Secure lock, Non vented, Pre-attached pressure-activated anti-siphon valve, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td></td>
<td><strong>Pain Management Sets</strong></td>
</tr>
<tr>
<td>13045</td>
<td>Latex-Free, GemStar® Pump Set, Integral pressure-activated anti-siphon valve, Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13047</td>
<td>Latex-Free, GemStar® Pump Set with PCA Extension, Integral pressure-activated anti-siphon valve, Secure Lock, Nonvented with PCA injector and female Luer Lock™ adapter, Microbore tubing, 96 in (244 cm)</td>
</tr>
<tr>
<td>13261</td>
<td>Latex-Free, GemStar® Pump Set and Extension Set with integral pressure-activated anti-siphon valve, Secure Lock, Non-vented, Microbore tubing, 110 in (279 cm), Yellow Striped Tubing</td>
</tr>
</tbody>
</table>
## Chapter 11

### GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Physical</th>
<th>The GemStar Pump is composed of latex-free components only.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions:</td>
<td>Height: 5.5 in. (14.0 cm)</td>
</tr>
<tr>
<td></td>
<td>Width: 3.8 in. (9.7 cm)</td>
</tr>
<tr>
<td></td>
<td>Depth: 2.0 in. (5.1 cm)</td>
</tr>
<tr>
<td>Weight:</td>
<td>Approximately 17 oz. (482 grams) excluding batteries</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport and Storage Environment</th>
<th>Store in cool and dry environment.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient Temperatures:</td>
<td>-4° F to +140° F (-20° C to +60° C)</td>
</tr>
<tr>
<td>Relative Humidity:</td>
<td>10% to 90%</td>
</tr>
<tr>
<td>Atmospheric Pressure:</td>
<td>0–10,000 ft. (0–3,000 m) equivalent pressure</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Operating Environment</th>
<th>Ambient Temperatures: +41° F to +104° F (+5° C to +40° C)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Power Sources</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>AC Mains:</td>
<td></td>
</tr>
<tr>
<td>List 13026-01 (USA) complies with UL 544</td>
<td>Wall-mount AC mains adaptor; 6 ft. (1.8 m) cord molded plug</td>
</tr>
<tr>
<td>Input: 110 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>List 13072-01 (Universal) complies with CSA 22.2 No. 601.1 and UL 60601-1</td>
<td>Tabletop AC mains adaptor; molded plug</td>
</tr>
<tr>
<td>Input: 100–240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>Battery:</td>
<td>Two disposable AA alkaline or lithium batteries</td>
</tr>
<tr>
<td>Battery Pack:</td>
<td>Rechargeable using GemStar AC Mains Adaptor</td>
</tr>
<tr>
<td>Docking Station:</td>
<td>Mounts on an I.V. pole; 12 ft. (3.6 m) cord</td>
</tr>
<tr>
<td>Input: 100–240 VAC</td>
<td>Output: 3.0 VDC</td>
</tr>
<tr>
<td>Internal rechargeable battery</td>
<td></td>
</tr>
</tbody>
</table>
11. GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Capacity</strong></td>
<td>Using two fresh, disposable AA batteries or a charged battery pack, at temperatures between 59° F and 95° F (15° C and 35° C), the pump is capable of delivering approximately:</td>
</tr>
<tr>
<td></td>
<td>96 hours at rates below 5 mL/hr</td>
</tr>
<tr>
<td></td>
<td>48 hours at rates at or above 5 mL/hr but below 25 mL/hr</td>
</tr>
<tr>
<td></td>
<td>24 hours at rates at or above 25 mL/hr but below 125 mL/hr</td>
</tr>
<tr>
<td></td>
<td>3000 mL at a rate of 125 mL/hr or higher</td>
</tr>
<tr>
<td><strong>Pump Mechanism</strong></td>
<td>Volumetric, Piston Driven</td>
</tr>
<tr>
<td><strong>Memory Protection</strong></td>
<td>Current program and 400-event (history) log protected by internal lithium battery-backed memory for at least one year after power is removed</td>
</tr>
<tr>
<td><strong>Operating Controls</strong></td>
<td>One 23-key keypad; bolus, data port, and AC mains jacks; bolus button</td>
</tr>
<tr>
<td><strong>External Power LED</strong></td>
<td>Green LED marked with plug icon lights continuously when pump is connected to AC mains power</td>
</tr>
<tr>
<td></td>
<td>Green LED flashes when pump is connected to external batteries</td>
</tr>
<tr>
<td><strong>Alarm LED</strong></td>
<td>Red LED marked with alarm icon lights during alarm conditions</td>
</tr>
<tr>
<td><strong>Audible Alarm</strong></td>
<td>The audible alarm is user-adjustable from the maximum volume down to silent</td>
</tr>
<tr>
<td></td>
<td>The alarm automatically reverts to the maximum volume if the user does not respond within one minute</td>
</tr>
<tr>
<td><strong>Display</strong></td>
<td>Backlit, four-line-by-sixteen-character alphanumeric graphics display</td>
</tr>
<tr>
<td></td>
<td>Backlight on AC: Continuous</td>
</tr>
<tr>
<td></td>
<td>Backlight on Batteries: Continuous during programming, program review, and history display; otherwise activated by keypress or alarm; not activated by bolus request</td>
</tr>
<tr>
<td><strong>Real Time Clock</strong></td>
<td>Accuracy of ±5 minutes per month or better at temperatures between 59° F and 95° F (15° C and 35° C)</td>
</tr>
<tr>
<td><strong>Print Function</strong></td>
<td>Port &amp; Interface: RS-232 serial interface port (data port), minimum baud rate of 2400, isolated circuit</td>
</tr>
<tr>
<td></td>
<td>Printers: Seiko DPU 414 or compatible serial printer</td>
</tr>
<tr>
<td><strong>System Accuracy</strong></td>
<td>± 10% for rates of 0.1 mL to less than 5 mL/hr</td>
</tr>
<tr>
<td></td>
<td>± 5% for rates of 5 mL to 1000 mL/hr</td>
</tr>
</tbody>
</table>
11. GemStar Pump Specifications

<table>
<thead>
<tr>
<th>Air Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON: Pump alarms at approximately 0.5 mL of air</td>
</tr>
<tr>
<td>Alarms for any bubble greater than 500 microliters with a tolerance of 200 microliters</td>
</tr>
<tr>
<td>2 mL: Pump alarms at approximately 2 mL of air</td>
</tr>
<tr>
<td>Alarms when pump detects 2.0 ±1.0/0.2 mL of air in 6 mL of total volume delivered</td>
</tr>
<tr>
<td>OFF: Alarm is not activated</td>
</tr>
<tr>
<td>Recommend using air-eliminating filter when Air Sensitivity is set to OFF</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Occlusion Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distal Occlusion: Alarms when pump detects distal pressure within a selectable range:</td>
</tr>
<tr>
<td>Low: 7 psi (48 kPa) ± 5 psi (±34 kPa)</td>
</tr>
<tr>
<td>Medium: 12 psi (83 kPa) ±8 psi (±55 kPa)</td>
</tr>
<tr>
<td>High: 26 psi (179 kPa) ±14 psi (±96 kPa)</td>
</tr>
<tr>
<td>Proximal Occlusion: Alarms when pump detects proximal pressure less than or equal to -4 psi (-28 kPa)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pump Self-Tests and Safety Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self-test performed when the power switch is activated</td>
</tr>
<tr>
<td>Diagnostic routine, including motor speed and air-detection monitoring, is repeated continuously while the pump is powered on</td>
</tr>
<tr>
<td>Error and alarm conditions are indicated by both audible and visual alarms; delivery in progress is stopped, if appropriate (refer to Chapter 6 Troubleshooting)</td>
</tr>
</tbody>
</table>
11. GemStar Pump Specifications

Occlusion Information

_Avoiding Bolus Infusion After Occlusion_

1. Press [STOP].
2. Close the distal slide clamp.

3. Press the cassette release button to eject the cassette from the pump.

4. Press down on  to open the flow stop.
5. Wait 10 seconds.

6. Press down on  to close the flow stop.
11. GemStar Pump Specifications

7 Load the cassette.

CAUTION: Ensure all four cassette latches are clearly visible after the cassette is installed. Refer to Loading the Cassette on page 30.

Note: Ensure the tubing is behind the tubing guide (at the distal end).

8 Open the distal slide clamp.

9 Review the program. Press [ reviewing] to begin review.

10 Press [START] to start the pump.
11. GemStar Pump Specifications

**Stored Occlusion Volume**

<table>
<thead>
<tr>
<th>Pressure Setting</th>
<th>Delivery Rate of 25 mL/hr at</th>
<th>Pressure Limit</th>
<th>Stored Volume in mL</th>
<th>Time to Occlude in seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Macro</td>
<td>Micro</td>
<td>Macro</td>
</tr>
<tr>
<td>Low</td>
<td></td>
<td>7 psig (48.3 kPa)</td>
<td>7 psig (48.3 kPa)</td>
<td>0.26</td>
</tr>
<tr>
<td>Medium</td>
<td></td>
<td>14 psig (96.5 kPa)</td>
<td>13 psig (89.6 kPa)</td>
<td>0.54</td>
</tr>
<tr>
<td>High</td>
<td></td>
<td>32 psig (220.6 kPa)</td>
<td>30 psig (206.8 kPa)</td>
<td>1.24</td>
</tr>
</tbody>
</table>

**Delivery Rate Accuracy**

The following trumpet curves represent the typical flow rate deviations, both positive and negative, from the programmed flow rate under test conditions defined by International Electrotechnical Commission (IEC) Standards for infusion pumps. Using these curves, the medical professional may determine if the device can be expected to perform in a manner suitable for the drug or fluid to be infused. The pump sets used in this test are comparable to GemStar Pump Set List 13273.

The typical accuracy for this device is ± 5% of the programmed rate for most conditions, after a period of normalization. It is recommended that the medical professional refer to the following curves when making decisions regarding drug and fluid administration.

A single fault condition occurs when a single means for protection against a safety hazard in equipment is defective or a single external abnormal condition is present. The maximum over-infusion volume from a single fault condition is based upon the calculation of the maximum time to generate an alarm times the maximum rate possible (1000 mL/hr) as a consequence of the fault. This has been determined not to exceed 2.78 mL.

**CAUTION:** When using pre-filled vials, the system may underdeliver at low flow rates.
11. GemStar Pump Specifications

Trumpet Curves

The Trumpet Curve Graphs following the Example show representative maximum and minimum percent flow rate deviation from the programmed rate over time. This information was developed in accordance with IEC 60601-2-24: 1998, Sub-Clause 50.102. Refer to this standard for detailed information.

How to read a Trumpet Curve Graph (Refer to example on the following page):

The graphs following the Example plot flow rates at 30 second intervals for the first 2 hours and for the 96th hour of delivery. The graph plots mean delivery rate error (Average of 3 pumps) for the 2nd hour and the 96th hour as a straight line. The graph also presents maximum and minimum average delivery rate error for this interval plotted by averaging delivery errors over intervals of 2, 5, 11, 19 and 31 minutes ("Trumpet Curve").

Example

From the Trumpet Curve Graph sample that follows, find the 5 minute interval (A) at the horizontal axis and read the corresponding points (B) and (C) on the vertical axis. The values are approximately +2.8% and -0.5%.

This means that at the rate of 25 mL/hr the average maximum flow rate fluctuation for any 5 minute time interval during the 2nd hour of operation was within the limits of +2.8% and -0.5% from the nominal rate. The average delivery rate error over the entire 2nd hour was +1.6% (D).

For other time intervals look at other points at the horizontal axis and determine corresponding limits as above.
A trained professional can use the resulting graphs to select a pump with the appropriate startup and flow characteristics to suit the clinical application.

Note: As an example of how the trumpet curves can be used, consider the maximum and minimum deviations at the 5 minute average interval. The upper curve provides the maximum expected delivery rate error over a 5 minute interval, the lower curve provides the minimum expected delivery rate error over a 5 minute interval. An example would be Dopamine administered at 5 µgm/kg/min. At 5 minutes, the average drug delivery error would be within the range of +2.8% and -0.5% of the expected nominal rate.
11. GemStar Pump Specifications

FLOW RATE
0.1 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Start Up
11. GemStar Pump Specifications

FLOW RATE
0.1 mL, 0 mm Hg Delivery Head, Hour 96

PERCENT ERROR
0.1 mL, 0 mm Hg Delivery Head, Hour 96
11. GemStar Pump Specifications

FLOW RATE
1 mL, 0mm Hg Delivery Head, Start Up

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Start Up
11. GemStar Pump Specifications

FLOW RATE
1 mL, 0 mm Hg Delivery Head, Hour 96

PERCENT ERROR
1 mL, 0 mm Hg Delivery Head, Hour 96
11. GemStar Pump Specifications

FLOW RATE
25 mL, 0 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, Start Up
11. GemStar Pump Specifications

FLOW RATE
25 mL, 0 mm Hg Delivery Head, 96 Hour

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, 96 Hour
11. GemStar Pump Specifications

FLOW RATE
25 mL, -100 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, -100 mm Hg Delivery Head, Start Up
11. GemStar Pump Specifications

FLOW RATE
25 mL, +100 mm Hg Delivery Head, Start Up

PERCENT ERROR
25 mL, +100 mm Hg Delivery Head, Start Up
11. GemStar Pump Specifications

FLOW RATE
25 mL, 0mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

Rate (mL/hr)

Time (minutes)
— Actual Rate --- Programmed Rate

PERCENT ERROR
25 mL, 0 mm Hg Delivery Head, -20 in H20 Filling Head, Start Up

Flow Rate Variability (%)
Chapter 12

Warranty/Technical Assistance

The GemStar Pump has been carefully manufactured using high-quality components. It is warranted to be free from defects in material and workmanship for a period of one year from the date of purchase under normal use and service. The warranty on the optional battery pack and other accessories is limited to 90 days.

On return to Hospira, the pump will be repaired or replaced within the terms of this warranty. Material returned to Hospira must be properly packaged and sent freight prepaid.

This warranty shall not apply if the pump has been repaired by anyone other than Hospira qualified service personnel; or altered in any way which, in Hospira’s judgment, affects its stability or reliability; or if the serial number has been altered, effaced, or removed.

THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED.
12. Warranty/Technical Assistance

For customer service within the United States, contact:
1-877-9HOSPIRA (1-877-946-7747)

For technical assistance and product return authorization within the United States, contact:
1-800-241-4002

For additional technical assistance, including Technical Service Bulletins, technical training, and product information, visit the Web site at:
www.hospiraparts.com

After authorization, ship prepaid product returns to the following address:
Hospira, Inc.
Technical Support Operations
755 Jarvis Drive
Morgan Hill, CA 95037

Note: Outside the U.S, contact your local Hospira sales office.
Index

Numerics
1-hour dose limit, 43
4-hour dose limit, 43

A
AC mains
  power connector, 4
  power indicator, 3
Pump Specifications, 119
  regarding handling and maintenance, 11
  regarding pump operation, 11
  warnings and cautions, 11, 12
AC Mains Adaptor
  connecting to, 18
  warnings and cautions, 11, 12
administration set. See pump set
air sensitivity, 59
  regarding air-in-line infusion, 10
  specifications, 121
air-in-line alarm, 9, 10
  test of, 99
alarm messages, 78–84
  alert messages, 85–87
anti-siphon valve, 10, 28, 29

B
BACK-UP key, 3, 26, 49, 54
  batteries, 67
  alarm messages, 78–84
  battery compartment, 4
  battery pack connector, 4
  installing disposable batteries, 17
  maintenance, 89
  power check, 96
  specifications, 119
  using the rechargeable battery pack, 19
  warnings and cautions, 10–11, 13
  baud rate, 120
  configuration settings for the data
    port, 65, 70
  switch settings for Seiko printer, 66
bolus, 8, 45
  bolus button, 4
  bolus delivery, 44–45
  bolus dose interruptions, 45
  connecting the bolus cord, 106, 116
  history, 50
  locking the pump, 74
  occlusion information, 122
  optional system components, 103
  in Pain Management therapy, 41–45
  print history, 50, 61
  1-hour or 4-hour dose limit, 43

C
carrying cases
  using the Hospira carrying cases, 109–114
cassette, 28
  alarm message, 79
  cassette pocket, 4
  cassette release button, 4
  cleaning of, 89–91
  inspection of, 95
  loading the cassette, 30
  releasing the cassette, 31
  warnings and cautions, 10–11
Change History, ii
CHANGE key, 3, 26
Change Menu, 6
clinician instructions, 73–76
locking the pump, 74
program and deliver a clinician activated 
loading dose, 75
unlocking the pump, 75
configuration settings, data port, 65
connecting the bolus cord, 106
connecting the GemStar AC Mains 
Adaptor, 18
connecting to a computer, 68
See also data port
connecting to the Seiko printer, 67
See also data port
continuous delivery
in Pain Management therapy, 41–46
contraindications for use, 9

D
data port, connecting to, 64–69
configuration settings, 65
connecting to a computer, 68
connecting to the Seiko printer, 67
connector, 4
Delivery Mode Menu, 6
accessing the Delivery Mode Menu, 24
disconnecting the pump, 21
distal end, 28, 33, 97
distal occlusion, 5, 58
alarm message, 80
occlusion sensitivity, 121
occlusion sensor setting, 59
test of, 98
troubleshooting, 80
docking station, 104
connecting the bolus cord and printer 
cable, 116
connecting the pump, 115
disconnecting the pump, 116
dose limit, 43

E
event log, See history

F
flow stop, 28, 31, 32, 34, 36, 39, 122
Full Lock, 46, 56–57
lock level functions, 57
locking the pump, 74
unlocking the pump, 75

G
GemStar pump components, 4
GemStar pump features, 5
GemStar pump layout, 2–3

H
HELP key, 3, 7, 26, 42, 53, 76, 77
HELP mode, 7
history, 5, 44, 45, 50, 89
display bolus history, 55
display, clear history, 54
print, bolus history, 50, 61

L
loading dose, 43
clinician activated loading dose, 75
delivery, 45–46
in Pain Management therapy, 41
loading the cassette, 30
lock, 3
Container Lock, 46, 56–57, 74
Full Lock, 46, 56–57, 74
keypad lock, 5, 50, 56
keypad lock level functions, 57
locking the pump, 74
Luer Lock, 10
Rate Change Lock, 46, 56–57, 74
lockboxes
using the GemStar lockboxes, 106–109
locking the pump, 74
Luer Lock, 10
M
maintenance, 89–91
  cleaning and disinfecting, 89
  cleaning the cassette pocket and tubing channel, 91
  cleaning the pump case, 90
  recommended cleaning solutions, 90
  repair, 91
Menu
  Delivery Mode, Change, Options, 6

N
new container, 5
  starting a new container, 27
  troubleshooting, 86, 88

O
  occlusion, 58
    changing the occlusion sensor settings, 59
  occlusion information, 122–124
  occlusion sensitivity, 121
  See also distal occlusion; proximal occlusion
  occlusion sensor
    changing the occlusion sensor settings, 59
    See also occlusion; distal occlusion; proximal occlusion
  Operating Modes
    Help, Programming, Run, Stop, 7
  operation test, 93–101
    air-in-line test, 99
    cassette pocket and latch inspection, 95
display test, 96
    distal occlusion test, 98
    equipment required, 93
    keypad test, 96
    LED test, 97
    Operation Test Checklist, 101
  power check, 96
  printing the results, 99
  proximal occlusion test, 98
test setup, 94
  volume accuracy test, 97
  optional system components, 103–116
  OPTIONS key, 3
    display shift totals, 53, 76
  Options Menu, 6, 49–69
    Histories, 51
    Keypad Lock, 56
    Operation Test, 55
    Print, 61
    Pump Settings, 58
    Review Program, 51
    Set Clock, 60
    Speed Protocol, 62
  other display messages, 88

P
Pain Management therapy, 41–48
  1-Hour or 4-Hour Dose Limit, 43
  bolus delivery, 44
  changing a Pain Management therapy, 46
  Delivery Mode menu, 24
  features and specifications, 41
  loading dose delivery, 45
  programmable ranges, 48
  programming of, 42–44
  Programming Worksheet, 48
  power indicator, 3
  power sources
    power check, 96
    selecting, 16
  powering on the pump, 22
  prime, 3, 29
  priming, 9
  priming extension sets, 39
  priming pump sets using pre-filled vials, 36
priming pump sets without a drip chamber, 32
priming pump sets without a drip chamber using the PURGE Key, 34
See also prime; purge
Print, 61
printer
  connecting to pump, 67
  connecting to the data port, 64
  connecting to the docking station, 116
serial cable, 104
programmable ranges
  in Pain Management therapy, 48
Programming Menu, 6
Programming Worksheet
  Pain Management, 48
proximal end, 28, 97
proximal occlusion
  alarm messages, 83
  occlusion sensitivity, 121
test of, 98
pump components, 4
pump features, 5
See also pump settings
pump layout, 2–3
pump set, 10–13, 27, 117–118
pump settings, 3, 50
  air sensitivity, 59
  change pump settings, 58
  occlusion sensor, 59
  sound level, 60
pump specifications, 119–121
PURGE key, 3
  priming pump sets without a drip chamber using the PURGE Key, 34
releasing the cassette, 31
RUN mode, 7
S
SILENCE key, 3
Speed Protocols, 5, 50, 61
  assign, review/recall, delete, 62–63
START key, 3
starting a new container, 27
STOP key, 3
STOP mode, 7
T
technical assistance, 138
troubleshooting, 77–88
  alarm messages, 78–84
  alert messages, 85
  other display messages, 88
U
unlocking the pump, 75
UP/DOWN key, 26
W
warnings and cautions, 9
Y
YES/ENTER key, 3, 26, 42
R
Rate Change Lock, 46, 74
lock level functions, 57
locking the pump, 74
CAUTION: Federal (USA) law restricts this device to sale by or on the order of a physician or other licensed practitioner.

DANGER: Possible explosion hazard exists if used in the presence of flammable anesthetics.

Authorized Representative:
Hospira
Finisklin Business Park
Sligo, Republic of Ireland

The ‘C’ and ‘US’ indicators adjacent to the CSA Mark signify that the product has been evaluated to the applicable CSA and ANSI/UL Standards, for use in Canada and the U.S., respectively. This ‘US’ indicator includes products eligible to bear the ‘NRTL’ indicator. NRTL, i.e. National Recognized Testing Laboratory, is a designation granted by the U.S. Occupational Safety and Health Administration (OSHA) to laboratories which have been recognized to perform certification to U.S. Standards.

Equipment providing a degree of protection higher than that for Type B equipment against electrical shock particularly regarding allowable leakage currents and having an F-Type applied part.

Protected against dripping water.

Attention: Consult accompanying documents.

GemStar and LifeShield are registered trademarks of Hospira, Inc. Luer Lock is trademark of Hospira, Inc., Seiko, Vesphene II se, Manu-Klenz, Formula C, Teflon, Velcro, CLAVE, and Microsoft, Windows, and Windows NT are not trademarks of Hospira.

This document and the subject matter disclosed herein are proprietary information. Hospira retains all the exclusive rights of dissemination, reproduction, manufacture and sale. Any party using this documentation accepts it in confidence, and agrees not to duplicate it, in whole or in part, nor disclose it to others without the written consent of Hospira.

© 2005 Hospira, Inc.
Lake Forest, Illinois 60045, USA
Printed in USA

Hospira GemStar Manual 430-00899-A02 (Rev. 02/05)